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On 2015-07-21, I based this file on the concept that we should be kind to our audience, with recommendations 
by Rick Darke and others.  And when COVID-19 hit, a sister gave me many of her Best Practices.  Thank you, 

Sis!  And it seems that every time I help 👪 family, friends, or 👥 colleagues on a project, or do my own project, 

there is another gotcha or two, leading to new Lessons Learned. 
 

I 📝 record and maintain these helps on these subjects to:  (A) reduce new-technology teething pains, (B) keep 

these processes repeatable, and (C) keep myself organized.  For date this file last updated, please see page 

footer.  For info on 🌲 green or < /> programming subjects, please see this document's sister docs. 
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1 Weeks before the presentation 

1.1 Learn how to talk 

Watch ▶ video "How to Speak" by Patrick Winston https://YouTu.be/Unzc731iCUY. 

□ For full effect, select the video link, then icons ⛶ fullscreen, ㏄ captions, ▶ Play, and ⛶ ☒ Skip Ads. 

□ Will take an hour, but is well worth it. 
□ More from this speaker at https://OCW.MIT.edu/search/?q=Patrick+Henry+Winston. 

 

1.2 Find a technical support person 

Unless you are extraordinary: 
□ If possible, arrange to have a support person to focus on the tech stuff, while you focus on your audience, 

material and presentation.  If you have such a support person, verify that they have a copy of this 
document, and determine how much of this content you can delegate! 

 

□ Tech Support person:  If the presentation will be amplified or recorded outdoors, find out how to prevent wind 
noise. 

 

1.3 Should your meeting/presentation/conference/gathering be live in-

person, or digital virtual? 

I am adding new material here at high speed, so if you don't see something now, check back soon. 
If you know something that I don't, please send comments to the author. 

1.3.1 First steps 

□ [Host]  Determine if your meeting or presentation: 

Must be live in-person (in a room). Go to the next section "Prepare your presentation". 

You can hold or give it remotely (a distributed-

team video-meeting/conference/gathering or 

webinar, via digital technology). 

Continue immediately below ... 

 
□ [Presenters]  You should be working on your presentation as in the next section "Prepare your presentation". 

 

□ [Host]  Determine which distributed-team web video-conferencing software you will use.  I have used 
about five of them.  Most are fine, but some take longer to set up, some take reboots, and some are more 
trouble-prone.  Among your options: 
o Zoom Cloud Meetings or Zoom Meetings by Zoom Video Conferencing zoom.us.  Installs right away!  

Reliable!  If you have newbies log on 4 minutes before the meeting/videoconference/webinar, you have a 
chance of getting everyone on! 

 [Host/Presenters/Panelists/Participants/Attendees] on a 📱▯ smartphone or tablet will be 

asked to install app Zoom Cloud Meetings or Zoom Meetings by Zoom Video Conferencing zoom.us, 
but it goes very quickly (one press, I think). 

 [Host/Presenters/Panelists/Participants/Attendees] on a 💻 computer with default browser 

Firefox will be asked to install app Zoom Cloud Meetings or Zoom Meetings by Zoom Video 
Conferencing zoom.us, but it goes very quickly (one click, I think), and requires no reboot. 

 [Host/Presenters/Panelists/Participants/Attendees] on a 💻 computer with default browser 

Chrome will be able to run quickly (one click, I think), without installing any software! 

 Participants on a 💻 computer with default browser Firefox, Edge, Safari, Opera, Vivaldi or Brave? 

o Google Meet https://meet.google.com (formerly, Google Hangouts video call). 

https://youtu.be/Unzc731iCUY
https://ocw.mit.edu/search/?q=Patrick+Henry+Winston
mailto:eric.piehl@gmail.com?subject=[EP]%20Comments%20on%20ericpiehl.altervista.org/present.pdf
https://en.wikipedia.org/wiki/Comparison_of_web_conferencing_software
https://zoom.us/
https://zoom.us/
https://zoom.us/
https://meet.google.com/
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 Joining a meeting/videoconference/webinar is easily done by anyone with a Google account (not 
necessarily a Gmail address). 

 Including presenting:  sharing your desktop or window! 
 Hosting a meeting/videoconference/webinar: 

 From 2020-April/October, is free for up to 100 people with a Gmail account (a Google account isn't 
sufficient?). 

 Before 2020-April (and after 2020-October if Goggle doesn't change their mind), requires a Google 
Workspace (formerly G Suite) subscription. 
o You might already have a subscription via your employer or NGO. 
o For-profit organizations pay for Google Workspace (formerly G Suite). 
o Nonprofit organizations use Google Workspace (formerly G Suite) for Nonprofits for free (after 

some authentication). 
o Government agencies use Google Workspace (formerly G Suite) for free (after some 

authentication). 
o People with no affiliations above can pay for Google Workspace (formerly G Suite), starting in 

2021? 
o As Google Workspace (formerly G Suite) for Education tools enter classrooms across Canada, 

some parents are asking to opt out. 
 [Host]  To start the meeting, go to meet.google.com > button "Start a meeting" > button "Join now" 

> Copy/Paste the "Meeting ready" link and send to the other Participants, via email, SMS text, or 
other means. 
o If everyone at the meeting are all coworkers running the same calendar appointment software 

(such as Microsoft Exchange Server), you can instead Paste it into a Meeting, and invite everyone. 
o If you are not all coworkers running the same calendar appointment software, do not Paste it into 

a Meeting, and invite everyone.  Invitees running an integrated email/calendaring software 

(Microsoft Outlook, or 🍎 Apple macOS, iPadOS or iOS) will be fine.  But I hear from invitees who 

aren't running integrated email/calendaring software, that they are shown nothing.  So put the 
invitation in a normal email or SMS text message. 

o Skype (too retail?) and Skype for Business (being deprecated in favor of MS Teams). 

o Microsoft Teams.  In early 2020, added to Microsoft Office 365, and branded Microsoft 365. 
o Cisco Webex Personal or paid;  Teams, Meetings, Events, etc. 
 Very functional.  Different room feature is way cool! 
 As of 2020-08, interface is a bit clunky, which surprised me since Webex created this marketspace. 

o Adobe Connect Meetings, Webinars and Learning. 
 13 Reasonable Alternatives to Adobe's Expensive Apps. 

o Citrix GotoMeeting. 
o LogMeIn GoToWebinar.  Not bad, except fails to launch under browser Firefox.  Controls (links, Q&A, etc.) 

behind orange arrow. 
o crowdcast. 
o Hopin online event platform. 

 Very functional.  Different room features is way cool! 
 Saw an organization, a first-time user of the software, use Hopin very well for an important fundraiser, to 

great effect.  Nice! 
o Slack. 

o 🍎 Apple FaceTime (too retail?). 

o Meta Platforms, Inc./Facebook WhatsApp and Messenger Rooms. 
o Demio webinar software. 
o Uberconference. 
o 8x8 Jitsi. 

o Comparison of some of the above. 
o More thoughts in Consumer Reports article "Working from Home because of COVID-19?  These Tech Ideas 

can make it Easier" https://consumerreports.org/home-office/work-from-home-covid-19-tech-that-will-
make-it-easier/. 

 
[Thanks for the tips, N and J!] 

□ [Host] [Presenters/Panelists] [Participants]  If you are going to do this a lot, you want to visit your 

favorite 📱💻 computer store Gamer section to look at comfortable, fits-you: 

o 🎤🔊 earbuds-with-microphone, or 

o 🎤🔊 headset  (headphones with 🎤 microphone), such as the HyperX Cloud Stinger at Best Buy or Amazon.  

May be cordless or corded. 

 If corded, its 🔊 audio plug will be of type 3½ mm male TRRS plug [4-conductor, stereo with mic] (not 

TS [2-conductor, mono], nor TRS [3-conductor, stereo]), with Tip Ring Ring Sleeve containing, 

https://www.google.com/nonprofits/products/apps-for-nonprofits.html
http://www.cbc.ca/radio/spark/episode-401-1.4694935/as-google-for-education-tools-enter-classrooms-across-canada-some-parents-are-asking-to-opt-out-1.4694939
http://www.cbc.ca/radio/spark/episode-401-1.4694935/as-google-for-education-tools-enter-classrooms-across-canada-some-parents-are-asking-to-opt-out-1.4694939
https://meet.google.com/
https://www.webex.com/
https://lifehacker.com/13-reasonable-alternatives-to-adobes-expensive-apps-1846699369
https://wildones.org/log/download/200419guidebook/Procedures/TIPS%20FOR%20USING%20CITRIX%20GOTOMEETING.pdf
https://www.crowdcast.io/
https://hopin.to/
https://demio.com/
https://www.uberconference.com/
https://8x8.vc/
https://www.lifewire.com/whatsapp-doubles-number-of-video-chat-participants-4843453
https://www.consumerreports.org/home-office/work-from-home-covid-19-tech-that-will-make-it-easier/
https://www.consumerreports.org/home-office/work-from-home-covid-19-tech-that-will-make-it-easier/
https://www.bestbuy.com/site/video-games-accessories/gaming-headsets/pcmcat1572279759550.c
https://www.wired.com/gallery/best-gaming-headsets/
https://bestbuy.com/site/hyperx-cloud-stinger-wired-stereo-gaming-headset-for-pc-ps4-xbox-one-nintendo-wii-u-mobile-devices-red-black/5590001.p
https://smile.amazon.com/gp/product/B01L2ZRYVE
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respectively, analog signals for LeftAudio RightAudio Ground Microphone (CTIA) (not OMTP).  This 

works for 💻 computers newer than 2016 or so.  For  computers older than 2016 or so, it may have an 

adapter that changes that one 3½ mm male TRRS plug to two 3½ mm male TRS plugs (one for 🎤 

microphone, one for 🔊 speakers). 

 If any different, I have never found any adapter combination that will get you what you want. 

 If you get a 🎤🔊 headset, remember the name of it, for when you have to tell your 💻 computer to use it 

for 🔊 audio or 🎤 microphone. 

□ [Host] [Presenters/Panelists]  Test your videoconference software as below, and get used to it. 

o TODO:  Find out if any functions are not available (or hidden behind the meatballs button ... More) on 📱▯ 

smartphone or tablet. 

1.3.2 Two weeks before the meeting/videoconference/webinar 

□ [Host]  Decide if your particular distributed-team video event is a (details are for Zoom, others similar). 
o You will need to know this decision when you schedule the meeting or webinar, a few minor bullets below. 

 

Meeting/videoconference/gathering Webinar 

Among peers/colleagues. Sage-on the-stage, top-down broadcast. 

Real-time participation/discussion/feedback through 📹 

video, 🔊 audio, and 💬 Chat box. 

Feedback/interaction only through optional 💬 

Chat box and Q&A box. 

Optional small-group breakouts. No group breakouts. 

Roles: Roles: 

   [Host]  [1] a Participant with all controls, including 
whiteboard. 

[Host]  [1] a Panelist with all controls. 

[CoHosts]  [0+] a Participant who also .... 
May be Host's Participants Moderator and/or Chat 

Moderator. 

[CoHosts]  [0+] a Panelist who also ...  
May be Host's Attendees Moderator 

and/or Chat/Q&A Moderator. 

[Presenters]  [0+] a Participant who will Share Screen 

[Present now] [Share]. 

[Panelists]  [0+] an Attendee who also 

can been seen in 📹 video and heard by 🔊 

audio, and can Share Screen [Present 
now] [Share]. 

[Participants]  [2-100] ["Pro" 100-500-1,000] 

participates two-way via 📹 video, 🔊 audio, 💬 Chat. 

[Attendees]  [0-100 (-10,000)] 

participates two-way via 💬 Chat and Q&A, 

receives video/🔊 audio of Host and 

Panelists, sends video/🔊 audio only if Host 

directs. 

Free "Personal Meeting".  Originally, used to kick off 
everyone at 40 minutes into having 3+ Participants.  Users 
on a budget learned to re-invite everyone and continue 
their meeting.  But during the COVID-19 coronavirus 

pandemic, Zoom sometimes extends your meeting 
indefinitely.  $15-65-105+/month "Pro". 

$55-105-145+/month "Pro", "Business" or 
"Enterprise" subscriptions. 

Comparison charts.  Carmen tips. 

 
□ [Host]  Get used to your software by doing all the actions in section below Two days before the 

meeting/videoconference/webinar. 
 

□ [Host]  Schedule the meeting with your system provider, with options recommended by your provider. 
For Zoom: 
o Schedule the meeting with your system provider.  Usually turns out to be https://zoom.us/meeting or 

https://zoom.us/webinar > button New Meeting. 

o Many of the settings below have defaults set above. 
o If you want strong security, set meeting: 
 In section Meeting ID, set to Generate Automatically. 

 In section Security, check Passcode and Waiting Room. 
 In section Video, set Host = Off and Participant = Off.  
 In section Meeting Options, uncheck Enable join before host and check Mute participants upon 

entry. 

o 🔊 Audio = Telephone and Computer Audio to allow Participants/Attendees to get their 🔊 audio from a 

📱▯💻 smartphone/tablet/computer, or a 📱☎ separate phone (their choice). 

https://support.zoom.us/hc/en-us/articles/115005474943-Meeting-and-Webinar-Comparison
https://teaching.resources.osu.edu/toolsets/carmenzoom/guides/carmenzoom-tips
https://support.zoom.us/hc/en-us/articles/201362413-How-Do-I-Schedule-Meetings-
https://zoom.us/meeting
https://zoom.us/webinar
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o Join before host = Enable. 
I like it, particularly if Host thinks s/he may not be online 10 minutes early, particularly if you set 

Alternative Hosts/CoHosts. 
But if the Host is very conscientious, and you have reason to fear your Participants/Attendees, disable this. 

o Only authenticated users can join meetings from Web client = ON. 
o Mute participants upon entry = ON. 
o Virtual Waiting Room = Enabled if you are a large organization, or must post the meeting link on an open 

website hours or days before the meeting. 
o Virtual Waiting Room = Disabled if you are a small organization, and do not post the meeting link on an 

open website hours or days before the meeting. 
o Save. 

o Send the meeting announcement as a "Save the Date" to all CoHosts/Panelists/Participants/Attendees, so 
they can keep this time clear in their calendars.  You will send out a much more detailed update You will 
send out the rest of this information a little later. 

 

[Thanks for the tips, C!] 
□ [Host]  Prepare an Interactive Agenda, with everything a Participant could ever need for the 

meeting/videoconference.  Attendees will need less information for their webinar.  Items needed may include: 
o A title or overall reason for the meeting. 
o Date, time, duration, and how to remotely-attend the meeting. 
o A cellphone mobile number to call or SMS text if they have problems. 
o An agenda of specific issues the group needs to cover — the reason for the meeting! 
o Links to all background information and reference materials. 
o Ground Rules, including: 

 Start your 📹 video, and do not mute it without good reason.  [This promotes engagement.] 

 Mute your 🔊 audio, until you are about to say something.  [Minimizes distracting noises.] 

 During the Presentation, put your questions and comments in the 💬 Chat or Q&A box--will handle at 

end.  [Frees up Host to deal with technology and agenda.] 

o Activities designed to engage each Participant/Attendee individually. 
o Breakout sessions in Breakout Rooms. 
o A Call-to-Action to prove each CoHost/Panelist/Participant can fully participate, perhaps: 
 Has successfully launched the software. 

 Has successfully edited (and thus seen!) the Interactive Agenda. 
 If this Interactive Agenda is in a shared workspace, such as Google Drive Docs or Slides: 

 Each CoHost/Participant will have a place (agenda item 0?) to edit demonstrating that they got on 
the system, and has edited the Interactive Agenda.  They may also be able to take notes/make 
contributions right there! 

 Host's designated official Note Taker can also take notes right there. 

□ [Host]  Send out this Interactive Agenda to all Attendees, via email, SMS text, or other means. 
o If everyone at the meeting are all coworkers running the same calendar appointment software (such as 

Microsoft Exchange Server), you can instead Paste it into a Meeting, and invite everyone. 
 If you are not all coworkers running the same calendar appointment software, do not Paste it into a 

Meeting, and invite everyone.  Invitees running an integrated email/calendaring software (Microsoft 

Outlook, or 🍎 Apple macOS, iPadOS or iOS) will be fine.  But I hear from invitees who aren't running 

integrated email/calendaring software, that they are shown nothing.  So put the invitation in a normal 
email or SMS text message.  Example text: 
Please join us for [Event], which we have scheduled for [date and time]. 

[While community-transmission remains high, and weather keeps us from meeting 

outdoors,] we will hold this event remotely, wherever you can access a ☎ phone 

or 📱▯💻 Internet. 

To Join from a 📱▯💻 smartphone, tablet or computer: 

  If you want to practice from a new device, select the link below now. 

  If you are experienced Zoomer, ten minutes before the event, select link 

[videoConfURL].   

    Do whatever it says:  OK, Yes, Open Link, whatever. 

    Turn up your 🔊 sound, and Start your   audio and 📹 video. 

To Join from a ☎ classic phone, please ☎ call our techie, as below. 

  Call him now — there is something he needs to set up. 

  Afterward, he will give you instructions to join 🔊 audio-only.** 

If *any* trouble of any kind, please 📱☎ call our techie at [phone URL], and he 
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will get you going. 

  Yes, this phone link is clickable from a 📱 smartphone. 

We look forward to seeing you soon! 

** = will look something like: 

To Join from a ☎ classic phone, join 🔊 audio-only by: 
  Dial by your location [list of phone numbers]. 

  When prompted, give it: 

    Meeting ID:  [meetingID]. 

    Passcode: [passcode] 

  Find your local number at [URL]. 

[Thanks for the tip, C!] 
□ [Host] [Presenters]  If you are going to be speaking or presenting for a while, particularly if you are 

going to be recorded, round up a standing desk;  or a regular desk with your 💻 laptop elevated by a box 

or stack of books. 
o Doing so, your voice will project better. 

o And if you are a bit congested, minimize any fluids in your lungs. 

 
[From me.] 

□ [Host] [Presenters]  Start rehearsing, with your technology, using all the stuff below. 

o If your 📹 🔊 video or audio freezes sometimes (known by your support team monitoring via 🎤🔊 headset 

or headphones, or via your Chat Moderator monitoring for audience complaints): 
 when presenting, Stop your Video, 
 have others in the household stop their bandwidth-heavy activities, 
 connect to your Wi-Fi without your Wi-Fi extender, or with your Wi-Fi extender, 

 have your support team connect your 💻 computer to your router via an Ethernet cable instead of Wi-Fi, 

 make a note to contact your broadband-provider, 
 find a location with better bandwidth (e.g., work, library), and/or 
 arrange a tour of your local library's podcast studio (and for presentation day, make a reservation -- 

under COVID-19, only one reservation per day!).  Ours has: 
 a soundproof room with a Internet, phone, table, 4 chairs, instructions,  

 3 🎙🎤 professional microphones and closed-back headphones, connected to a ... 

 RØDECaster Pro audio mixing console (mixing board) https://rode.com/rodecasterpro, which can 
store audio recordings on a microSD (μSD microSDHC microSDXC microSDUC TF) card, and 
optionally transmit it over a USB-A/USB-C cable to a ... 

 💻 laptop running ... 

 RØDECaster Pro Podcast Studio software (to configure something, and one way to get your recording 
off the mixing board), and 

 Adobe Audition 2020 software (to edit your 🔊 audio recording or podcast). 

 Instructions and signup are at https://kdl.org/podcast.  Under the COVID-19 coronavirus 
pandemic, they only allow one signup per day, so you might as well reserve it all day! 

Hours https://kdl.org/locations/ADA.  Questions "Penni Zurgable (PZurgable@kdl.org)". 
 I made a test audio recording and transferred it to my computer.  Way cool! 

 Need to verify that I can fix soft recording level, by adjusting mixer board's Output-level slider. 

 Need to determine how to feed podcast studio's 🔊 good audio into a Zoom presentation, or a 📹 

video recording of someone showing and doing stuff on a computer.  Presumably from the mixer's 

Audio Outs, into a computer, using some combination of cables and connectors. 

 May practice editing an 🔊 audio recording using podcast studio's Adobe Audition 2020 software. 

o Need to determine a way to,  
  while people are waiting for a Zoom presentation to start,  
  while sharing a nice slide with the name and subject of the presentation and that it will start soon, 
  have neither silence nor the panelists talking among themselves,  

  but have some 🔊 music or nature sounds, 

  so that people know their 🔊 audio is working. 

This is regardless of using a podcast studio or not. 
This ought to work, but it doesn't:  On slide-sharing computer > launch presentation with intro slide with 

the name and subject of the presentation and that the presentation will start soon > launch 🔊 audio > 

launch Zoom > button Share Screen (or New Share)  > check checkbox Share sound or Share 
computer audio and/or Optimize for video clip > select the window with the intro slide > button Share 

> verify slide and 🔊 audio are visible and audible over Zoom.  The slide is visible, but the audio is not.  

Does the 🔊 audio have to be embedded in the slide? 

o Keep rehearsing, breaking as needed, until things go smoothly. 

https://www.ikea.com/us/en/search/products/?q=standing+desk
https://rode.com/rodecasterpro
https://kdl.org/podcast
https://kdl.org/locations/ADA
mailto:PZurgable@kdl.org)


 
EricPiehl.alterVista.org/present.pdf  2024-03-28                      page 7 

o Write down everything you did, so later when you do it live, you can do it just like that. 
 Test like you fly;  fly like you test.  --aviation software  

 Train like you fight;  fight like you train.  --army  
 More details at EricPiehl.alterVista.org/#pgm3.  Meaning, in this case, to practice, practice, practice, 

until it all goes smoothly, and then we set it in stone, and do it for real just like that.  No last-
minute changes, unless absolutely necessary. 

1.3.3 Three business days before the meeting/videoconference/webinar 

□ [Host]  Send your Interactive Agenda to all CoHosts/Presenters/Panelists/Participants/Attendees. 
 

□ [Host] [Presenters]  If you have cleaning people, verify they are not scheduled to be in your place during 
your meeting. 

□ [Host] [Presenters]  If you are going to be speaking or presenting for a while, particularly if you are 
going to be recorded or might be congested, round up: 
o a standing desk;  or  

o a regular desk with your 💻 laptop elevated a lot (so you can stand) by a banker's box or tall stack of sturdy 

books. 
Doing so: 
o Your voice will project better. 

o If you are a bit congested, minimize any fluids in your lungs. 
 

□ [Host] [Presenters/Panelists]  If your 📹 webcam videocamera is in your 📱▯💻 smartphone, tablet or 

computer, make a way to: 
o Have your camera held steady (not on a card table). 
o Elevate/raise your camera as high as your eyes or so.  Or higher. 

o Pitch your camera down, roughly horizontal, with your nose near the middle, like a talking-head on 📺 TV. 

 Avoid camera angles that look up your nose, or that show you looking down to read your script. 
 I would rather see your floor than your ceiling. 

o If your camera quality is poor, buy an  external webcam.  Not very expensive. 
□ [Host] [Presenters/Panelists]  If you wear glasses, and have a ring light around or a bright light near your 

📹 webcam or videocamera, test the video to see if the light gives you annoying reflections in your glasses.  

Keep looking — intermittent reflections as you move are even more annoying than static reflections. 
o If you do, move your light upward by 30 cm (a foot), and retest.  Your audience will never listen to you if 

they are focusing on the reflections in your glasses. 

1.3.4 Two days before the meeting/videoconference/webinar 

□ [Host] [Presenters/Panelists] [Participants]  How to look better on Zoom and other videocalling apps. 
□ [Host] [Presenters/Panelists] [Participants]  Understand how to use your software: 

o If Cisco Webex, test your software with https://webex.com/test-meeting.html. 
o If Google Meet, [Host] will start the meeting, via meet.google.com > button "Start a meeting" > button 

"Join now" > Copy/Paste the "Meeting ready" link and send to the other Participants, via email, SMS text, or 
other means. 
 If everyone at the meeting are all coworkers running the same calendar appointment software (such as 

Microsoft Exchange Server), you can instead Paste it into a Meeting, and invite everyone. 
 If you are not all coworkers running the same calendar appointment software, do not Paste it into a 

Meeting, and invite everyone.  Invitees running an integrated email/calendaring software (Microsoft 

Outlook, or 🍎 Apple macOS, iPadOS or iOS) will be fine.  But I hear from invitees who aren't running 

integrated email/calendaring software, that they are shown nothing.  So put the invitation in a normal 
email or SMS text message. 

o If Zoom: 
 If you haven't already done so, do a Zoom test.  
 If you haven't already done so, and if you are ever going to Participate via the Zoom app (i.e., from a 

📱▯💻 smartphone, tablet or computer with default browser Firefox [Edge?  Safari?  Opera?  Chrome?  

Vivaldi?  Brave?], or a 💻 computer with default browser Chrome and you ask to install the app): 

 Participants on a 📱▯ smartphone or tablet will be asked to install the Zoom app, but it goes very 

quickly (one press, I think). 

 Participants on a 💻 computer with default browser Firefox will be asked to install some software, but 

it goes very quickly (one click, I think), and requires no reboot. 

 Participants on a 💻 computer with default browser Chrome will be able to run quickly (one click, I 

think), without installing any software! 

https://ericpiehl.altervista.org/#pgm3
https://www.ikea.com/us/en/search/products/?q=standing+desk
https://smile.amazon.com/dp/B082CJPNB5
https://www.howtogeek.com/673264/how-to-look-better-on-zoom-and-other-video-calling-apps/
https://www.webex.com/test-meeting.html
https://meet.google.com/
https://zoom.us/test
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o Participants on a 💻 computer with default browser Firefox, Edge, Safari, Opera, Vivaldi or 

Brave? 

 Install app Zoom Cloud Meetings or Zoom Meetings by Zoom Video Conferencing zoom.us. 
 Launch your app Zoom (not Zoom Meeting), and login.  See the app window Zoom appear. 
 Select your [not-] photo in the upper-right corner > Check for updates > if your software asks you 

to apply an update, do that.  You want to get all the latest security enhancements. 

 Select the your [not-] photo in the upper-right corner > [gear] Settings > see the Zoom window 
Settings appear: 
o In tab General > UNcheck Use dual monitors. 
o In tab General > check Remind me 15 minutes before upcoming meetings. 
o In tab General > check Stop my video when display is off or screen saver begins. 
o In tab Video > check Always display participant names on their video. 
o In tab Video > UNcheck Spotlight my video when I speak. 

o In tab 🔊 Audio > check Mute my 🎤 microphone when joining a meeting. 

o In tab Share Screen > uncheck Enter full screen automating when joining a meeting. 

o In tab Share Screen > uncheck Maximize Zoom window when a participant share screen. 

o In tab Share Screen > check Show Zoom windows during screen share. 
o In tab Share Screen > check Silence system notification when sharing desktop. 
o In tab Chat > check Show unread message badge for channels. 
o If you want to appear somewhere cool or hide your messy room, in tab Virtual Background > set 
a virtual background. 
 [Simplest] Blur! 

 [Middle] Photos from properties of your (my) local land conservancy appropriate for the season. 
 [Best]    Custom-made for your organization, including your branding. 

o If you wish, poke around the other settings. 
 Select your [not-] photo in the upper-right corner > My Profile (or [gear] Settings > tab Profile > 

button Edit My Profile) > see webpage https://xxx.zoom.us/profilexxx  appear. 
o In tab Profile > set your profile picture to you or your avatar, so other Participants/Attendees 

can see your still pic when your 📹 video is disabled. 

o In tab Settings > subtab Meetings > set Audio Type to Telephone and Computer Audio, to 

allow Participants/Attendees to get their 🔊 audio from a 📱▯💻 smartphone/tablet/computer, or a 

📱☎ separate phone (their choice). 

o In tab Settings > subtab Meetings > set Join before Host.   
I like it, particularly if Host thinks s/he may not be online 10 minutes early, particularly if you set 
Alternative Host(s). 
But if the Host is very conscientious, and you have reason to fear your Participants, disable this. 

o In tab Settings > subtab Meetings > set three Require a password ... settings. 
o If you wish, poke around the other settings. 

 Because these options will probably change over time, you may want to review these setting from 
time-to-time. 

o If you get your meeting video on a 📱▯💻 smartphone/tablet/computer with a 🎤🔊 microphone and 

speakers, you can get and give your 🔊 audio over your 📱▯💻 smartphone/tablet/computer. 

o If you get your meeting video on a 💻 computer with no 🎤🔊 microphone or speakers, and your Host setup 

your meeting with Zoom option 🔊 Audio = Telephone and Computer Audio, you can get and give your 

🔊 audio over a 📱☎ separate phone (your choice).  For details, see your meeting invitation, or Host. 

o After launching the meeting, the Zoom app will start out in: 
 Active Speaker View, showing current video of: 

 the person currently speaking (or whichever Participant Host has Spotlighted [don't do it] or you 
have Pinned [don't do it, unless you are VW or have an iPhone]), plus  

 if Host has not Spotlighted anyone and you haven't Pinned anyone, as much of the Gallery View [Tile 
View] [Together Mode] as will fit. 

o You can also tell the Zoom app to show: 

 Gallery View [Tile View] [Together Mode], showing current video of each Panelist/Participant who are 

sharing their video, in a grid reminiscent of the opening credits in the old 📺 TV show The Brady Bunch. 

o If on a 📱▯ smartphone or tablet, change between these views by swiping your screen left or right. 

 If there are more than 4 people in your meeting, Gallery View [Tile View] [Together Mode] may have 
more than one screen.  Swipe your screen left or right. 

o If on a 💻 computer, change between these views by selecting the button in the upper-right corner. 

 If you wish, you may also split your real estate with Active Speaker View or Gallery View [Tile View] 
[Together Mode] by selecting View Options > Side-by-side Mode. 

https://zoom.us/
https://www.lifewire.com/zoom-security-how-to-stay-safe-during-your-video-calls-4801664
https://www.tomsguide.com/how-to/how-to-change-your-zoom-background
https://www.tomsguide.com/how-to/how-to-change-your-zoom-background
https://www.newsweek.com/blur-background-zoom-microsoft-teams-google-meet-video-calls-1577020
https://naturenearby.org/10-zoom-backgroundsfrom%20my%20local%20land%20conservancey/
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 If you want to do this automatically all-the-time, select your profile picture > Settings > tab General 
> check Side-by-Side Mode. 

o After a Host/Presenter/Panelist/Participant does a Share Screen [Present now] [Share], the Zoom 
screen adds: 

 Share Screen [Present now] [Share], showing the presentation, desktop or browser tab of the 
Host/Presenter/Panelist/Participant who did the Share. 
 On Android, you will also see a small thumbnail video of the Presenter/Panelist or Active Speaker. 

o [EP likes this.]  If you don't like seeing this, see this minor bullet under iOS bullet below. 
 On iOS, you will also see a thumbnail video of the Presenter/Panelist or Active Speaker. 

o If you [like VW] don't like this speaker thumbnail, have your designated Participants/Attendees 
Moderator, during the presentation, Stop everyone's Video, presumably using their third window 

— the List of Participants (and their status). 

 On a 💻 computer in fullscreen mode, you will also see a thumbnail, that you can (use icons along top) 

change between super-minimalist Active Speaker thumbnail, Active Speaker thumbnail, mini-
Gallery thumbnail, Gallery thumbnail, and full Active Speaker View.  I like the middle option. 

o [EP likes this.]  If you don't like seeing this, see this minor bullet under iOS bullet above. 

 On a 💻 computer not in fullscreen mode, you will also see a mini-Gallery thumbnail along the top.  

Don't swap this with the Presentation. 

o If on a 📱▯ smartphone or tablet, change between these views by swiping your screen left or right. 

o If on a 💻 computer, change between these views by selecting the button(s) along the top. 

o Look for security icon "Your client connection is encrypted" in upper-left corner. 

 
o There are all kinds of cool functions available via buttons on the ... 

Zoom [Google Meet] [MS Teams] command bar at top or bottom of screen (if not visible, press screen) 

    Button     Does what ...     For whom ... 

Join Audio or 

🔊 Audio Settings 

 ⋮ > Settings 

If you don't hear anything. 

[Host] [Presenters/Panelists] [Participants] or 
[Attendees] 

Mute   Unmute      

 🎤 . 
Share/not share your 🔊 audio. [Host] [Presenters/Panelists] [Participants] 

Start or Stop video   

 📹 . 
Share/not share your video. [Host] [Presenters/Panelists] [Participants] 

Security Show/not show this. [Host] 

List of Participants 

 👥 . 

Meeting details 
 

 
 

Show/not show this (📱 

smartphone users may find this 
under meatballs button ... More). 
May Invite another Participant. 
May mute or disallow Share 

Screen [Present now] [Share] 
any or all Panelists and 

Participants. 

[Host] [Presenters/Panelists] [Participants] 
 

 
[Host] [Presenters/Panelists] [Participants] 
[Host] 

Chats 

 💬 . 

Show/not show text questions, 
comments, info, etc., typed by 

Host, Panelists, Participants or 

Attendees (📱 smartphone users 

may find this under button 

Participants or ... More). 

[Host] [Presenters/Panelists] and 
[Participants/Attendees] 

Raise Hand 
Inform Host that you wish to be 
allowed to speak. 

[Attendees] 

Q&A 

If webinar, place to ask questions 

and receive answers, separate 
from Chats.   
Works for established 

organizations. 
Broken for a new organization. 

[Attendees] 

Polls 

Set a new Poll. 

If previous question active, see 
results. 

[Host]  

 
[Panelists] [Attendees] 

Share Unshare 

Present now 

Share/not share your 💻 computer 

screen. 
[Host] [Presenters/Panelists] [Participants] 

... More If other buttons were collapsed [.../Attendees] 
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 ⋮   into here. 

End meeting or 

Leave meeting  

📞 Leave call 
Will ask you to confirm. 

[Host] or 

[Presenters/Panelists] 
[Participants/Attendees] 
[All] 

Zoom help https://support.zoom.us.  Google Meet help https://support.google.com/meet#topic=7290350. 

1.3.5 The day before the meeting/videoconference/webinar 

□ [Host]: 
o Verify that all newbies have successfully launched the software. 
o Verify that all newbies have Edited the Interactive Agenda. 
o Consider sending out a meeting reminder. 
o Set up meeting option Live Transcript.  How? 

 
□ [Host] [Presenters/Panelists]: 

o Do all presentation preparation steps below in Section 2 "Business day before the presentation". 
o Lay out clothes for tomorrow with bright color(s) on top.  No charcoal gray nor muted blue.  You want to 

keep Participants/Attendees engaged. 

1.3.6 The day of the meeting/videoconference/webinar 

□ [Host] [Presenters/Panelists]  Wear a bright color(s) on top.  No charcoal gray nor muted blue.  You 
want to keep Participants engaged. 

□ [Host] [Presenters/Panelists] [Participants]  How to look better on Zoom and other videocalling apps. 
□ [Host] [Presenters/Panelists]  Eat a healthy meal, drink plenty of water. 

□ [Host] [Presenters/Panelists] [Participants]  Clean your 📹 webcam camera lens, and attach 

external devices. 
o On a real camera, I clean my lens with a Costco optics-cleaning spray and microfiber cloth. 

o On my 📱💻 smartphone and computer, I turn off my display, spray glass- or counter-cleaner onto a paper 

towel, and wipe the camera lens and display.  Oops, probably should not use glass-cleaner on the lens. 

o If you have a 🎤🔊 headset;  or 📹 external webcam, 🔊 speakers or 🎤 microphone, attach them. 

 And remember their names!  Later, after you launch your software, it will make it easier to select these. 
o If you are going to present, bring up your presentation software, set it to your presentation, and tell your 

software to Start Slide Show.   

 I find Presenter View fine, but this source says not to. 
o Run and go potty, and refill your drink of choice. 
o Jump up and down, and run up and down a long hallway (if you are a bit congested, this will minimize any 

fluids in your lungs). 
 

□ [Host]  30 minutes before the meeting: 

o Launch your meeting/conference/webinar app software on your 📱▯💻 smartphone, tablet or computer, and 

select your meeting;  or 

the link in your invitation email/SMS text/whatever, on your 📱▯💻 smartphone, tablet or computer. 

 If Google Meet, start the meeting via meet.google.com > button "Start a meeting" > button "Join now" 
> Copy/Paste the "Meeting ready" link and send to the other Participants, via email, SMS text, or other 
means. 

 If everyone at the meeting are all coworkers running the same calendar appointment software (such 
as Microsoft Exchange Server), you can instead Paste it into a Meeting, and invite everyone. 

 If you are not all coworkers running the same calendar appointment software, do not Paste it into a 
Meeting, and invite everyone.  Invitees running an integrated email/calendaring software (Microsoft 

Outlook, or 🍎 Apple macOS, iPadOS or iOS) will be fine.  But I hear from invitees who aren't running 

integrated email/calendaring software, that they are shown nothing.  So put the invitation in a 
normal email or SMS text message. 

 If Zoom: 

 ⊞ If Microsoft Windows 💻 computer, ⊞Start > Zoom > Start Zoom. 

 Select Meetings (among peers, with real-time discussion and feedback), or Video Webinar (sage-on 
the-stage top-down broadcast, with no feedback nor interaction). 

 If you want to hide your messy room or appear somewhere cool, set a virtual background. 
o [Simplest] Blur! 
o [Middle] Photos from properties of your (my) local land conservancy appropriate for the season. 
o [Best]    Custom-made for your organization, including your branding. 

 Set options Mute all on entry or Mute all. 

https://support.zoom.us/
https://support.google.com/meet#topic=7290350
https://sambleckley.com/writing/pockets.html
https://www.howtogeek.com/673264/how-to-look-better-on-zoom-and-other-video-calling-apps/
https://sites.bu.edu/nephtc/files/2018/11/Instruction-for-Zoom-Panelists.pdf
https://meet.google.com/
https://www.tomsguide.com/how-to/how-to-change-your-zoom-background
https://www.newsweek.com/blur-background-zoom-microsoft-teams-google-meet-video-calls-1577020
https://naturenearby.org/10-zoom-backgroundsfrom%20my%20local%20land%20conservancey/
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 Set up meeting option Live Transcript.  How? 
 The first window should probably be Gallery View [Tile View] [Together Mode]. 

 The second window should probably be the Active Speaker View or active speaker or presentation. 
 Appoint one or more CoHosts, via: 

o Zoom command bar > button Participants or More ... > CoHost;  or 
o Gallery View video > upper-right button … > Make CoHost?   -- Zoom help. 

 These CoHosts will then: 
o Open a third window, the List of Participants (and their status), and be your designated 

Participants/Attendees Moderator. 
o If your meeting is using option Virtual Waiting Room, let known-good Participants in. 

 But after you let them in, chat for a while before launching your introductions — participants 

come in about one per second. 
o Don't let anyone Present, without your approval.  Presumably using your third window — the List 

of Participants (and their status).  And other recently-added controls? 

o Open a fourth window, 💬 Chat box, and be your designated Chat/Q&A Moderator. 

 Rename your screen name to a short subset of First Last (org) (town) (she/her) or ... 

(he/his) or as relevant, via select your Gallery View video/photo/name > meatballs button "..." > 

Rename.  [On 2021-05-17, this option seems to no longer be there for Webinar Panelists.  Use next 
option?] 
 Doing it here will rename your screen name just for this session. 
 To rename your screen name for future sessions: 

o Launch app Zoom (not Zoom Meeting). 
o Select the your [not-] photo in the upper-right corner > My Profile (or [gear] Settings > tab 

Profile > button Edit My Profile) > left navigation Profile > Edit > Display name. 

o If your 📹 🔊 video or audio freezes sometimes (known by your support team monitoring via 🎤🔊 headset 

or headphones, or via your Chat Moderator monitoring for audience complaints): 
 when presenting, Stop your Video, 
 have others in the household stop their bandwidth-heavy activities, 

 connect to your Wi-Fi without your Wi-Fi extender, or with your Wi-Fi extender, 

 have your support team connect your 💻 computer to your router via an Ethernet cable instead of Wi-Fi, 

 make a note to contact your broadband-provider, 
 find a location with better bandwidth (e.g., work, library), and/or 
 arrange a tour of your local library's podcast studio (and for presentation day, make a reservation). 

o Silence your 📱☎ phones, and 💻 computer notifies. 

o Sequester or quiet your 🐦🐕🚼 bird, dog or children. 

o If running an app, periodically (every month or so?), and if you have a couple minutes before your meeting 
starts, ensure your app is up-to-date. 

o Run and go potty, and refill your drink of choice. 
o Jump up and down, and run up and down a long hallway (if you are a bit congested, this will minimize any 

fluids in your lungs). 
o As Participants/Attendees arrive, start engaging them.  How? 

 So they know they are connected and in the right place, have something for audience to 👀 look at: 

 a slide saying the topic of the talk or meeting, 
 the first slide in the presentation, 

 your live smiling video feed, 
 containing or overlain with the time it will start or a countdown clock, 
 something.  Don't wait for the appointed time to let people into the meeting. 

 So they know they are connected and their volume is good, have something for audience to 🔊 listen to: 

 cool music, 
 chat among the Presenters as you get ready, 
 chat among everyone signing on early, 
 something.  Don't let your audience sit in silence, worrying that their audio is set up wrong. 

 If you refuse to do this, at least let in all Participants/Attendees in time to see the whole presentation. 

 

□ [Presenters/Panelists]  20 minutes before the meeting: 

o Launch the link in your invitation email/SMS text/whatever, on your 📱▯💻 smartphone, tablet or computer. 

 If Zoom: 

 ⊞ If Microsoft Windows 💻 computer, ⊞Start > Zoom > Start Zoom. 

 If you want to hide your messy room or appear somewhere cool, set a virtual background. 
o [Simplest] Blur! 
o [Middle] Photos from properties of your (my) local land conservancy appropriate for the season. 
o [Best]    Custom-made for your organization, including your branding. 

https://support.zoom.us/hc/en-us/articles/206330935-Enabling-and-Adding-a-Co-Host#h_9c3ee7f2-b70c-4061-8dcf-00dd836b2075
https://www.lifewire.com/zoom-security-how-to-stay-safe-during-your-video-calls-4801664
https://www.tomsguide.com/how-to/how-to-change-your-zoom-background
https://www.newsweek.com/blur-background-zoom-microsoft-teams-google-meet-video-calls-1577020
https://naturenearby.org/10-zoom-backgroundsfrom%20my%20local%20land%20conservancey/
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o If you plan to see your speaker notes using Microsoft PowerPoint Presenter View, set up your windows: 
 Based on experience of WMGS: 

 If you are going to present over Zoom, and are using MS PowerPoint 2010 or earlier, and you have 
only one physical screen, then you will not be able to see your speaker notes, or you will not be 

able to Share your presentation screen. 
 If you have a second physical screen, or a version of MS PowerPoint later than 2010, you are fine. 

 Launch PowerPoint.  Put its window on 💻 laptop screen. 

 Launch presentation, with Use Presenter View. 

 Verify Presenter View is on 💻 laptop screen — this will keep Presenter's eyes and voice projection 

close to camera. 
 Verify Presentation is on external screen.  Later, you will Share this window. 

 Put distributed-team web videoconferencing software window(s) on your 💻 laptop screen, on top of 

PowerPoint Presenter View.  (You want to be looking at the camera.) 
 If Zoom:  

o The first window should probably be Gallery View [Tile View] [Together Mode]. 

o The second window should probably be the Active Speaker View or active speaker or 
presentation. 

o If you open a third window, it should probably 💬 Chat or Q&A box. 

o If you open a fourth window, it should probably be the List of Participants (and their states). 
 TODO:  Using Google Slides? 

o If you haven't already done so, tell your presentation software to Start Slide Show. 

o Silence your 📱☎ phones, and 💻 computer notifies. 

o Sequester or quiet your 🐦🐕🚼 bird, dog or children. 

o If your 📹 🔊 video or audio freezes sometimes (known by your support team monitoring via 🎤🔊 headset 

or headphones, or via your Chat Moderator monitoring for audience complaints): 
 when presenting, Stop your Video, 
 have others in the household stop their bandwidth-heavy activities, 
 connect to your Wi-Fi without your Wi-Fi extender, or with your Wi-Fi extender, 

 have your support team connect your 💻 computer to your router via an Ethernet cable instead of Wi-Fi, 

 make a note to contact your broadband-provider, 
 find a location with better bandwidth (e.g., work, library), and/or 
 arrange a tour of your local library's podcast studio (and for presentation day, make a reservation). 

 
□ [Participants/Attendees]  10 minutes before the meeting: 

o Launch the link in your invitation email/SMS text/whatever, on your 📱▯💻 smartphone, tablet or computer. 

 If Zoom:   [one-time only] 

 Participants on a 📱▯ smartphone or tablet will be asked to install the Zoom app, but it goes very 

quickly (one press, I think). 

 Participants on a 💻 computer with default browser Firefox will be asked to install some software, but 

it goes very quickly (one click, I think), and requires no reboot. 

 Participants on a 💻 computer with default browser Chrome will be able to run quickly (one click, I 

think), without installing any software! 

o Participants on a 💻 computer with default browser Firefox, Edge, Safari, Opera, Vivaldi or 

Brave? 
 If you want to hide your messy room or appear somewhere cool, set a virtual background. 

o [Simplest] Blur! 

o [Middle] Photos from properties of your (my) local land conservancy appropriate for the season. 
o [Best]    Custom-made for your organization, including your branding. 

o If part of your organization culture, type something in the 💬 Chat box like, "Hello from 

myTown/myOrg." 

o Silence your 📱☎ phones, and 💻 computer notifies. 

o Sequester or quiet your 🐦🐕🚼 bird, dog or children. 

 

□ [Presenters/Panelists] [Participants/Attendees]  Hope you have time: 

o Run and go potty, and refill your drink of choice. 
o Jump up and down, and run up and down a long hallway (if you are a bit congested, this will minimize any 

fluids in your lungs). 
o If you don't understand how to use your software, do your homework from two days ago. 
o If running an app, periodically (a couple times a month?) ensure your app is up-to-date. 

https://www.tomsguide.com/how-to/how-to-change-your-zoom-background
https://www.newsweek.com/blur-background-zoom-microsoft-teams-google-meet-video-calls-1577020
https://naturenearby.org/10-zoom-backgroundsfrom%20my%20local%20land%20conservancey/
https://www.lifewire.com/zoom-security-how-to-stay-safe-during-your-video-calls-4801664
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1.3.7 Showtime! 

□ [Host] or [Participants/Attendees Moderator]  If you kept out Participants/Attendees until showtime 

(perhaps using a practice session or waiting room): 
o Start letting in Participants/Attendees some minutes ahead, perhaps using Start webinar. 

As a cohost, Zoom shows Participants/Attendees arriving in my Participants/Attendees list at about 1 per 
second. 
I am not sure if this is because Zoom throttles: 
 Participants/Attendees arriving in the webinar, -OR- 
 Participants/Attendees showing up in my Participants/Attendees list. 

Until we rule out the former, and know it is the latter, ... 
o Start webinar or others let in the Participants/Attendees before the webinar starts by about: 
 (1 second) × (the number of Participants/Attendees you have waiting). 

o While they are coming in, do some light conversation.  Don't start to real content until the 
Participant/Attendee count slows to a level that makes you think only latecomers are arriving. 

□ [Host] or [Participants/Attendees Moderator]  If you hear 📄 papers rustling, 🐕 dog barking, etc., use 

Zoom command bar > button Mute all Participants. 
o If any Participant/Panelists wants to talk, they can unmute themselves. 

 

[Thanks for the tips, C!] 
[Host] [Presenters/Panelists] [Participants/Attendees]  Everyone is connected, and can participate in the 
meeting: 

□ [Host] [Presenters/Panelists]  Speak clearly and slowly -- it is the nature of these videoconferences -- 
Participants are seeing the speaker in much less clarity. 

 
□ [Host]  Welcome. 

□ [Host]  Go over the Ground Rules you wrote and distributed above. 
□ [Host] [Presenters/Panelists] [Participants/Attendees]  If you want, set Record Meeting. 
□ [Host]  Designate an official Note Taker.  [Frees up Host to deal with technology and agenda.] 

□ [Host]  Designate an official Chat/Q&A Moderator, who will do a variety of tasks listed below. 
o [Frees up Host to deal with technology and agenda.] 

□ [Host] or [Participants/Attendees Moderator]  Don't let anyone Present, without your approval.  

Presumably using your third window — the List of Participants (and their status).  And other recently-added 
controls? 

□ [Host] or [Participants/Attendees Moderator]  If you hear 📄 papers rustling, 🐕 dog barking, etc., use 

Zoom command bar > button Mute all Participants. 
o If any Participant/Panelists wants to talk, they can unmute themselves. 

 
□ [Host]  Handle each item on agenda in turn, taking every opportunity to engage each Participant 

individually.  Don't let Participants/Attendees zone out. 
□ [Chat/Q&A Moderator]  

o After most attendees have joined, issue a 💬 Chat message something like "If you have questions during the 

presentation, please use this Chat function to post your question.  We will collate, and ask them during or at 
end of the presentation." 

o Paste links to websites or notes the speaker mentions, perhaps repeating them 10 minutes in, for late-
comers. 

o Delete any posts that are harmful, mean, or completely off-topic. 
o Explain background info or acronyms if you think the audience might need it. 
o Give other helpful hints, such as: 
 To save a link here in Chat, launch link, then navigate back here.  After event ends, can read and Save. 
 To save entire Chat, in lower-right, if you see meatball icon "..." "More", launch it > "Save Chat" > 

button "Save in Folder" > launch that file. 
If Chat lower-right contains *no* meatball icon "...", you will have to use printscreens or "snip". 
Repeat occasionally, to get new posts.  Repeat again before the webcast ends. 

o Answer easy or specific questions. 

o Keep track of hard questions, or questions deserving group discussion. 
o Remove duplicate questions;  and combine similar questions, broadening their scope question as needed. 
o Sort these questions in order of importance or general-applicability. 

o Read aloud the questions during Q&A, leaving time for the Panelists to answer the question. 
o Be ready to halt long discussions, tabling for later email discussion, or for another day! 

 
□ [Host] or [Participants/Attendees Moderator]  When time to Present: 

o Turn on meeting option Live Transcript.  How? 
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o If your Participants/Attendees don't like seeing a thumbnail video of the Active Speaker or 
Presenters/Panelists [should only be an issue for iOS users]: 

 While Presenter starts presenting, Stop everyone's Video, presumably using your third window — the 
List of Participants (and their status). 

o Stop the 💬 Chat balloon from appearing over the presentation excessively: 

 💬 Chat window > meatballs button "..." > set Attendee Can Chat to Hosts and panelists.  If really 

bad, set to No one. 
 This is just for the duration of the presentation. 

□ [Presenters]  When time to Present: 

o Introduce yourself some, to let Participants/Attendees see that you are a real live person, and not some 
robot or video clip. 

o If you haven't already done so, tell your presentation software to Start Slide Show. 
o Tell your distributed-team web video-conferencing software to Share Screen (or New Share) [Present 

now] [Share]. 
 Do not select Screen 1 nor Screen 2.  Later, you will get so confused. 

 Select window PowerPoint Slide Show – filename. 

 Not window Screen n -- you might have other windows put on top of what you want to Share. 

 If your presentation includes 📹 video or 🔊 audio, or you otherwise want the audience to 🔊 hear audio 

from your computer, check checkbox Share sound or Share computer audio and/or Optimize for 
video clip. 

 Select button Share. 
 If your distributed-team web video-conferencing software window appears on top of your PowerPoint 

Presenter View, drag it away. 
o If you expect to advance your slides with the keyboard, have Windows give focus back to (click somewhere 

on) your PowerPoint Presenter screen. 

o If you have a bunch of newbies at your meeting, tell everyone: 
 "You should now see a slide of something descriptive. 

  {If you don't see that slide, and you are on a 📱▯ smartphone or tablet, swipe your screen left or right 

until you see that slide of something descriptive.} 

    {If you still don't see the slide, please report this using the 💬 Chat box. 

      To bring up the Chat box, use your Zoom command bar button 💬 Chat or Participants or More.... 

      {If you don't see the Zoom command bar, press anywhere on your screen until it appears.}}}" 

 "If you don't 🔊 hear anything, bring up the Zoom command bar > button Join Audio." 

o Present! 

o If your 📹 🔊 video or audio freezes sometimes (known by your support team monitoring via 🎤🔊 headset 

or headphones, or via your Chat Moderator monitoring for audience complaints): 
 when presenting, Stop your Video, 
 have others in the household stop their bandwidth-heavy activities, 

 connect to your Wi-Fi without your Wi-Fi extender, or with your Wi-Fi extender, 

 have your support team connect your 💻 computer to your router via an Ethernet cable instead of Wi-Fi, 

 make a note to contact your broadband-provider, 

 find a location with better bandwidth (e.g., work, library), and/or 
 arrange a tour of your local library's podcast studio (and for presentation day, make a reservation). 

o If Zoom makes you tired, make your photo or video feed invisible to you, via select your Gallery View 
video/photo/name > meatballs button "..." > Hide Self View. 
 To restore your self-view, select someone else's video/photo/name > meatballs button "..." > Show Self 

View. 
o If you are going to Post a recording of your presentation on YouTube, stop on the end slide for several 

seconds, over which you will later have YouTube place link cards to feature other videos, etc. 
o When done (if your final slide says "Q&A", perhaps after the first answer), Stop Share [___] [___] your 

screen, so your audience will see their normal Active Speaker View or Gallery View [Tile View] [Together 
Mode]. 
 Although your last slide should be Contributions.  Or a joke.  — How to Speak by Patrick Winston. 

o Ask your official Chat/Q&A Moderator to read out the questions they have been tracking. 

 Probably one-at-a-time, so the group or Panelists can answer each question in turn. 
 With duplicate questions removed;  and similar questions combined into one, broadening their scope as 

needed to include their collective content. 
 Sorted in order of importance or general-applicability. 
 If too many questions, or discussion on one question goes too long, table for later email discussion, or 

for the next meeting! 
 

□ [Participants/Attendees]: 

https://youtube.com/watch?v=Unzc731iCUY
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o To improve readability of the speakers' slides: 
 Select icon fullscreen, or Zoom top status bar View Options > Full Screen. 

 Try upper-right View > Standard > drag speaker pic to little-used part of screen. 
 Hide your mouse pointer by moving it the far right, and waiting for a couple seconds. 

 If you see Windows Taskbar, push ⊞Start twice. 

 To show text of what is being spoken, select Zoom command bar > button Live Transcript > Show 
Transcript, and optionally Subtitle settings... or Options. 

 If that button is not there, 💬 Chat the Host to turn on for that meeting.  How? 

 If transcript box gets in way of content, drag transcripts box to a little-used part of the screen. 
 If needed, Live Transcripts > Hide transcripts. 

 Hide the Zoom Command bar by keyboard [Alt] key. 

o When you 💬 Chat, set correctly the target-audience dropdown "Hosts and panelists" v "Everyone". 

 
□ [Host] or [Participants/Attendees Moderator]  After presentation, and before discussion or Q&A: 

o If at the beginning of the presentation, you stopped presenter's video, reStart their Video, presumably 

using your third window — the List of Participants (and their status). 

o If at the beginning of the presentation, you limited the 💬 Chat balloon from appearing over the 

presentation excessively, reAllow it: 

 💬 Chat window > meatballs button "..." > set Attendee Can Chat to Everyone. 

 
□ [Host]  Conclude: 

o Follow-up items, perhaps those listed by your official Note Taker. 
o Lessons Learned, perhaps those listed by your official Note Taker. 
o Next meeting? 
o Ask Presenters/Panelists for a final comment. 

o Final Call-to-Action for the Participants/Attendees. 
o Bye. 

□ [Chat/Q&A Moderator] or [Host]:  Save the contents of the Chat and/or Q&A boxes by: 

o 💬 Chat window > meatballs button "..." > Save Chat > Show in Folder.   

 If you don't like the folder, do 💬 Chat window > button File > somewhere. 

 Or you can Select-All Copy the contents of the box, and Paste into your favorite document or text 

editor, Saving it for later review. 
o If you are using a Q&A box, do the same for the contents of the Q&A window. 

□ [Host] [Presenters/Panelists] [Participants/Attendees]: 
o If recording, Stop Recording. 
o Hit command bar button Leave or End meeting. 
 If your software asks you to apply an update, do that. 

o If you wish, Exit software. 

o Release your 🐦🐕🚼 bird, dog and children. 

o Un-silence your 📱☎ phones, and 💻 computer notifies. 

1.3.8 After your meeting/videoconference/webinar 

□ [Host]  If you recorded it, receive the link to the recording, and if appropriate, Forward it to Participants 

and people who didn't make the meeting. 
□ [Host] [Presenters/Panelists] [Participants]: 

o Handle any follow-up items, perhaps those listed by your official Note Taker. 
o Handle any Lessons Learned, perhaps those listed by your official Note Taker. 

1.3.9 Further education 

TODO: 
□ See https://catlintucker.com/2018/06/googleslideagenda. 
□ See Google Certified Educator Preparation at https://youtube.com/playlist?list=PLMMcXoWg2jrKOKVx-

NpW_VoJqraTkundq. 

o Google Docs is video 3.  Google Slides is covered in video 5. 
o Have not looked at it yet. 

□ If above Zoom record fails, need to follow https://helpdeskgeek.com/windows-10/how-to-record-your-screen-

on-windows-10. 
  

https://www.lifewire.com/zoom-security-how-to-stay-safe-during-your-video-calls-4801664
https://catlintucker.com/2018/06/googleslideagenda
https://youtube.com/playlist?list=PLMMcXoWg2jrKOKVx-NpW_VoJqraTkundq
https://youtube.com/playlist?list=PLMMcXoWg2jrKOKVx-NpW_VoJqraTkundq
https://helpdeskgeek.com/windows-10/how-to-record-your-screen-on-windows-10
https://helpdeskgeek.com/windows-10/how-to-record-your-screen-on-windows-10
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1.4 Prepare your presentation 

□ If collaborating with a distributed team, please do in a shared workspace using: 

o Google Docs, Sheets and Slides, running on Google Drive, very good, free.  If you have a Gmail email 
account, you already have access to Google Docs, Sheets and Slides through your email account.  Spaces.  
Forms.  Drawings (Visio). 

o Microsoft Office Online, running on Microsoft OneDrive.  If you have an Outlook.com/Live Mail 
(formerly Hotmail) email account, you already have access to Microsoft OneDrive and Office Online 
through your email account. 

o Comparison of above two. 
o Or share folders or files with your team via Dropbox (Basic plan FREE) (I love this, and use all the time!), 

🍎 Apple iCloud, Box, pCloud;  or the more-secure milDrive, sync.com or SpiderOak ONE ($);  or 

other file hosting, file synchronization, or online backup services. 
If using Dropbox as your collaboration tool, tell your team ... 
 To see the full PowerPoint presentation (with script, etc.), 

on a 💻 computer with real Microsoft Office 2007 and above, launch the file from within: 

 ⊞ Microsoft Windows File Explorer/This PC (formerly Windows Explorer/My Computer), or 

 the new (2019-10-17/27?) Windows App "Dropbox".  Can launch this by, in the Notification 
Area (will be Action Center in Win10X) (formerly System Tray) (by the clock): 
o double-click icon Dropbox, or 
o single-click icon Dropbox > icon folder. 

 To see a cripple-ware version of the PowerPoint presentation, 

from any 💻 computer (▯ tablet?) (📱 smartphone?),  

launch the file from within a web browser interface.  Can launch this by: 

 in the Notification Area (will be Action Center in Win10X) (formerly System Tray) (by the clock), 
single-click icon Dropbox > icon world. 

 
□ In your presentation, cover Why before How before What, as in TED talk "Start with Why" by Simon Sinek or 

TED talk "Start with Why" by Simon Sinek. 
□ To be displayable on most equipment, try to get your presentation in a common format, such as .pdf 

documents (ensure built so text is searchable/copy-pasteable), .ppt .pps .pptx .ppsx .key 

presentations, or .avi .mp4 .3gp .mpg .ogg video.  For more help, please see my tools document. 

□ If your presentation is in format Adobe Photoshop Elements PSE or other unusual format, consider 
Exporting it to .pdf (ensure built with text searchable/copy-pasteable), or rebuilding it as.pptx or.key. 

□ If building it in Microsoft PowerPoint, 🍎 Apple Keynote, LibreOffice Impress, OpenOffice Impress, 

Google Slides, Prezi (very nice), Slidedog or other presentation software: 
o To use all available real-estate for your presentation, and avoid having your content pillarboxed, 

letterboxed, stretched or cropped, build your presentation with an aspect ratio identical or very-close 
to that on which it will be displayed: 

Aspect Ratio 
(width:height) 

For displaying (without content being pillarboxed, 
letterboxed, stretched or cropped) on ... From source material ... 

21½:9  2.39:1 UltraWide UWHD UWQHD monitors, after 2020.  

 21:9  2.33:1 Some 📱💻 smartphones and computers after 2020. Many movies. 

 19:9  2.11:1 📱 Smartphone 2019-20 Pixel 4 viewport=393x830. 
393-16=377-8=369-0•=369-6|-16m=357img 336ifr. 
                     369-32•=337-6|-16m=325img 302ifr. 

 18:9 2.0:1 Most 📱 smartphones, some 💻 computers 2017-2020.  

 16:9 1.8:1 

Zoom.  Full HD high-def 1080p 📺 TVs after 2005-

2013, 4K (UHDTV1), 8K (UHDTV2), over HDMI. 

Most 📱 smartphones 2010-2017. 

Many 📽 projectors and 💻 computers 2010-2020. 

Default in Microsoft 
PowerPoint 2013 and later, 
including Microsoft 365. 

 5:3 1.67:1 Some 📱 smartphones before 2010. 3x5" cards. 

16:10 1.6:1 
Many 🍎 Apple products, including macOS, iPadOS, 

iOS.  WXGA.  Some other 💻 computers before 2009. 

Very  near the golden ratio 

φ or ϕ = (1+√5)/2 ≈ 1.618. 

 3:2 1.5:1 
Some 📱 smartphones before 2010. 

Some 💻 computers after 2001. 

Photos on 35mm film, slides.  

4x6" cards. 

 √2 1.41:1  📄 A4 paper.  ~5x7" cards. 

 4:3 1.33:1 

VGA.  📺 TV before 2005-2013. 

Please discontinue using this aspect ratio, unless 
you know you will be showing your presentation in 

VGA or old 📺 TV format.  My 📱 smartphone in 2010. 

Default in Microsoft 
PowerPoint 2010 and prior. 
Consumer digital cameras. 

 

 1.29:1  📄Letter-sized paper 8½x11" 

https://get.google.com/spaces
https://google.ca/forms/about/
https://www.lifewire.com/google-drive-review-1356570
https://wikipedia.org/wiki/Comparison_of_file_hosting_services
https://wikipedia.org/wiki/Comparison_of_file_synchronization_software
https://wikipedia.org/wiki/Comparison_of_online_backup_services
https://www.ted.com/search?q=Simon+Sinek
https://youtube.com/embed/sioZd3AxmnE
http://ericpiehl.altervista.org/tools.pdf
https://prezi.com/
https://www.lifewire.com/free-microsoft-office-alternatives-1356334
https://en.wikipedia.org/wiki/Display_aspect_ratio
https://wikipedia.org/wiki/Golden_ratio
https://wikipedia.org/wiki/Golden_ratio
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 If you need to change your presentation's aspect ratio: 

To the presentation as a whole, use technique in 
https://duckduckgo.com/?q=powerpoint+aspect+ratio+change or 

https://google.com/search?q=powerpoint+aspect+ratio+change (in PowerPoint 2010 use ribbon tab 
View > Normal view, then ribbon tab Design > group Customize Page Setup > Slide Size Page 
Setup > the aspect ratio you chose above > OK), then . . . 

 After doing so, if using Microsoft PowerPoint 2010 or before: 
 For each slide: 

o For each image that got squished: 
 Right-click that image > Size and Position… > tab Size > Width down 1 and up 1 > Close. 

 That should fix it squishiness. 
 If not, make the height and width percentages the same. 
 If you have to, adjust so it looks about right. 

o Continue for all images that got squished. 

o Readjust the layout of elements on that slide, as needed. 
 Continue for all slides. 

 Save the presentation. 
 

o Use graphics/images/photos of as high quality as possible: 
 No small .jpg files, with their visible image bubbles. 

 Find a .jpg with more pixels. 

 If scanning (scanning info!) or making your own image, use a lossless format, such as .png .tiff 

.psd .flif .bmp.  TODO:  include .heif if easy to set for lossless image data storage (and maybe 

.avci .avcs .avif .avifs .heic .heics .heifs). 

 Prevent squished or skinny heads, by preserving you images' original aspect ratio. 
 For more help, please see my tools document.  Most of instructions on scanning are copied below. 

 

o If you have a slide with multiple complex graphics or thoughts, (such as five images plus text and 
background): 
 Break up that slide into multiple slides, so your audience can see it. 
 Or start with one overview slide, then drilling down to multiple slides, each with its own graphic or 

thought. 
 

o Spread-out all images out to the edges of your slide, maximizing image size, and minimizing margins, 

whitespace, and background. 
  

o Put minimal text on your slides, just enough so you can remember what you are talking about. 
 

o If you need to make a point involving a very-busy graphic that your audience will never be able to see: 
 Copy your graphic and hack it with big magenta (or other bright colors) circles (or arrows) that illustrate 

your point. 
 Give your audience a quick verbal overview of the graphics details, and make your point illustrated by 

your big magenta circles. 
 

o To see a great example of a slide deck, see http://www.pinchot.org/PDFs/Pinchot Lex (2014).pdf. 
 

o "You have too many slides … 

 with way too much text … 
 remove any titles … 
 remove any logos … 
 remove any whitespace … 
 >40-50-point font …" 
 and many more great ideas.   
   — ▶ video "How to Speak" by Patrick Winston https://YouTu.be/Unzc731iCUY.   

       More from this speaker at https://OCW.MIT.edu/search/?q=Patrick+Henry+Winston. 
 

o Never read your slides.   
 If you are going to just read your slides, you should make a video of the presentation, post it on 

YouTube, and have everyone watch it from home. 
 

https://duckduckgo.com/?q=powerpoint+aspect+ratio+change
https://google.com/search?q=powerpoint+aspect+ratio+change
http://ericpiehl.altervista.org/tools.pdf#page=18
https://en.wikipedia.org/wiki/Display_aspect_ratio
http://ericpiehl.altervista.org/tools.pdf#page=18
http://www.pinchot.org/PDFs/Pinchot%20Lex%20(2014).pdf
https://youtu.be/Unzc731iCUY
https://ocw.mit.edu/search/?q=Patrick+Henry+Winston
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o If during your talk you need some prompts or see your speaker notes, and you are using Microsoft 
PowerPoint, set your presentation to use Presenter View: 

 Connect your 💻 computer to a 📽 projector or 📺 TV, via an HDMI cable (after 2005-2013) or VGA 

cable (before 2005-2013). 

 🍎 If Apple macOS (Macintosh, iMac, iBook, and MacBook) 💻 computer, you may need a USB-C-to-

HDMI, DisplayPort-to-HDMI, or Mini-DisplayPort-to-HDMI cable or adapter.  Look on the back 
and sides of your computer. 

 Some computers may need a USB-C-to-HDMI cable or adapter.  Look on the back and sides of your 
computer. 

 ⊞ If Microsoft Windows 💻 computer, you cannot do this via a USB-A cable nor Chromecast or 

other wireless device — your 💻 computer will not recognize it as separate screen. 

 ⊞ If Microsoft Windows 💻 computer, set ⊞Win+P (or desktop > right-click Display Settings > scroll 

down main pane to section Multiple Displays) to Extend.  If trouble, more details. 

 🍎 If Apple macOS (Macintosh, iMac, iBook, and MacBook) 💻 computer, System Preferences > 

Displays > tab Arrangement > uncheck checkbox Mirror Displays to extend display across both 

screens.  If trouble, more details. 

 Bring up your presentation under PowerPoint, and drag its window to appear on your private display. 
 In PowerPoint tab Slide Show, group Monitors, check checkbox Use Presenter View and set 

dropdown Show On to be your public display. 
 Practice with it! 
 If you plan to use Microsoft PowerPoint Presenter View at C_ (MCLH, B_C and elsewhere), do not use 

their 💻 computer — it won't work without opening the lectern and moving an HDMI cable — so (A) 

bring your own 💻 computer, or (B) be prepared to open the lectern and move an HDMI cable and move 

everything back at the end. 
o TODO:  Using Google Slides? 

 
o Put your text over your images.  It's OK, it will be just fine.  Especially if you follow the next three major 

(and their minor) bullets . . . 

o Use fonts large enough for gray-hairs wearing trifocals.  Even if you can temporarily read the microscopic 
print common in BMW ads, some day you, too, will get presbyopia! 

o No ALL-CAPS.  That is SHOUTING, annoying, and hard to read. 
 In almost all places, use sentence case.  It is easiest to read. 
 For titles, it is OK to use Title Case. 

o Use colors that contrast with each other.  No gray-text-over-gray-backgrounds!  There are some good 
guidelines out there about choosing colors across each other on the color wheel, either two colors straight 

across from each other, three colors that cut the color wheel in thirds, etc. 
 If your text does not yet stand out from a busy background, select your text box object (the text box 

itself, not any particular text within it), and if using PowerPoint > ribbon tab Format > group Shape 
Styles > control Shape Fill > More Fill Colors ... > select a background color, and set transparency to 
about 50% > OK > experiment.  

o Most of this agrees with, but some of this conflicts with, ▶ video "How to Speak" by Patrick Winston 

https://YouTu.be/Unzc731iCUY. 

 
o Do not use PowerPoint's fancy transitions, e.g., pulling in from the right, or pixeling in in little squares.  

They distract from what you are saying.  Just make slides snap to the next slide. 
 Especially if you are ever going to present it over distributed-team web video-conferencing software, 

which chops your visuals into 1 or 2 frames a second, and/or delays them.  Yuck! 
 In Microsoft PowerPoint, do this with ribbon tab Transitions > select None. 
 Do not use PowerPoint's fancy transitions, e.g., pulling in from the right, or pixeling in in little squares.   

 
o Try very hard to not use timed transitions.  If the timing is so tight you can't take a question or 

comment in the middle, consider making this into a video, posting it on YouTube, and having everyone 
watch it from home.  Instead, do any one of: 

 Drive the slides yourself, by at transition time, walk over to your 💻 computer and hitting Enter or 

spacebar or .  (If using Prezi, only the latter works.)  Then you can walk back to the middle, point 

and so on.  
-OR- 

 Get (and practice with!) a wireless presentation-clicker(-remote-control) to advance the slides fore 
and aft.  M's has a built-in laser-pointer--very nice to have. 
 However, under Zoom and MS PowerPoint 2010, this doesn't work for us.  Test! 

-OR- 

https://www.wired.com/story/the-right-way-hook-your-laptop-up-to-tv/
https://www.wired.com/story/the-right-way-hook-your-laptop-up-to-tv/
https://wikipedia.org/wiki/Presbyopia
https://wikipedia.org/wiki/Letter_case#Case_styles
https://youtu.be/Unzc731iCUY
https://en.wikipedia.org/wiki/Comparison_of_web_conferencing_software
https://prezi.com/
https://smile.amazon.com/s/ref=nb_sb_noss?url=search-alias%3Daps&field-keywords=presentation+wireless+laser+pointer
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 Delegate a minion to sit in front of the 💻 computer and drive.  Instruct said minion to advance the slide 

whenever you twirl your right hand, or other signal you arrange. 

 
o No gradients, either!  Nor animations!  Turn them off! 
 Especially if you are ever going to present it over distributed-team web video-conferencing software.  

Yuck! 

 

o If you want  📹 video embedded in your slide: 

 Yes, do that with ribbon tab Insert > section Media > dropdown 📹 Video > as needed. 

 If you get error "Microsoft PowerPoint" "PowerPoint cannot insert a video from the selected file: 
 Verify that the path and the file format are correct. 
 Also try: 

o Install the latest version of the 🍎 Apple QuickTime player > "OK" "Help", click OK. 

o Set app QuickTime > Edit > Preferences > Player Preferences > uncheck checkbox "Show 

Content Guide at startup, as in https://discussions.apple.com/thread/8527642. 

o Restart PowerPoint and then try playing the video slide again. 
o Make a note to, after you are done with this project, uninstall the app, and do the rest of what the 

message says. 
 Decide whether you want the video slide to auto-launch (yes, you do). 

If Yes, then do that by ribbon section Video Tools > tab Playback > group Video Options > dropdown 
Start=Automatically > check checkbox Play Full Screen > verify the resolution. 

I had great success, and made it easier on the Presenter, by cloning a video slide into two slides: 
 The first slide was the first frame of the video, so the speaker could introduce it. 
 The second slide was the video, auto-launched.  Audience reaction was awesome as the "still" photo 

now started to move! 
 If you want that second slide to, when the video clip is finished, automatically advance to the next 

slide (yes, you do), then: 
o [Not sure, will look it up.  May be something like in audio paragraph below.] 

 If MS PowerPoint 2010 will not play a video or shows "Media Unavailable": 

o Install the latest version of the 🍎 Apple QuickTime player > "OK" "Help", click OK. 

o Set app QuickTime > Edit > Preferences > Player Preferences > uncheck checkbox "Show 
Content Guide at startup, as in https://discussions.apple.com/thread/8527642. 

o Restart PowerPoint and then try playing the video slide again. 
o Make a note to, after you are done with this project, uninstall the app, and do the rest of what the 

message says. 
 

o If you want 🔊 audio embedded in your slide: 

 Yes, do that with ribbon tab Insert > section Media > dropdown 🔊 Audio > as needed. 

 Decide whether you want the audio slide to auto-launch (yes, you do). 
If Yes, then do that by ribbon section Audio Tools > tab Playback > group Audio Options > dropdown 
Start=Automatically > [optional] check checkbox Hide During Show. 

I had great success, and made it easier on the Presenter, by cloning an audio slide into two slides: 

 The first slide shows the subject, so the speaker could introduce it. 
 The second slide was a duplicate of the first slide, but with the audio inserted, auto-launched.  

Audience reaction was ___. 
 If you want that second slide to, when the audio clip is finished, automatically advance to the next 

slide (yes, you do), then: 
o [One-time] ribbon Slide Show > section Timing > check checkbox Use Timings. 
o [Each slide] ribbon Transitions > section Timing > section Advance slide > check checkbox 

After (do not need to set any particular time here). 
 

□ Verify that videos and presentations always show ⛶ fullscreen, without taskbar, volume level nor other 
overhead.  Don't distract your audience. 
o For .pdf, use Ctrl+L, or View > Full Screen Mode. 

o For .ppt and .pptx, use F5, or Slide Show > From Beginning. 

 If MS PowerPoint 2010 will not play a video or shows "Media Unavailable": 

 Install the latest version of the 🍎 Apple QuickTime player > "OK" "Help", click OK. 

 Set app QuickTime > Edit > Preferences > Player Preferences > uncheck checkbox "Show 
Content Guide at startup, as in https://discussions.apple.com/thread/8527642. 

 Restart PowerPoint and then try playing the video slide again. 
 Make a note to, after you are done with this project, uninstall the app, and do the rest of what the 

message says. 

https://en.wikipedia.org/wiki/Comparison_of_web_conferencing_software
https://support.apple.com/downloads/quicktime
https://discussions.apple.com/thread/8527642
https://support.apple.com/downloads/quicktime
https://discussions.apple.com/thread/8527642
https://support.apple.com/downloads/quicktime
https://discussions.apple.com/thread/8527642
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o For .key, use ___? 

o For video files, your media player should have a ⛶ Fullscreen button, or View > Fullscreen. 

o If you have any issues with your current media player, install VLC media player from VideoLAN.  I love 
it!  Plays all kinds of files, tolerates incomplete or damaged media files, records played media, converts 
between file types, and grabs individual-frame screenshots.  [To take a cellphone mobile screenshot.] 

 
 

□ If time for your presentation is tight: 
o Arrange to have a minion keep you on time, with a set of cards or hand signals. 

o Have your local geek, seeking to break into mobile, code you a mobile app that turns your 📱 smartphone's 

display blue, then green when you have used your minimum time, yellow a minute before the end, and 

red to cut it off.  Sounds fun! 
 

□ If you are going to Post a recording of your presentation on YouTube, include an end slide, for several 
seconds, over which you can have YouTube place link cards to feature other videos, etc. 

 
□ Spellcheck everything! 

 

□ If you have speaker notes, print them off, and put the 📄 paper copy in your presentation kit. 

o If any technology problems, you can hold them in your hand, and speak with confidence. 
 

□ Save off a safety copy of your presentation in .pdf format. 

o Under Microsoft PowerPoint, File > Save As > .pdf.  This method makes the file searchable/copy-
pasteable! 

o If your presentation software starts fighting with your videoconference software (it will, someday!), you 
can show your audience the .pdf! 

 Test this with your videoconference software! 
o If presenting to a live audience, consider printing off these slides, too. 

 If you have a total power failure, have an assistant hold up your paper slides illuminated with a mobile-
phone flashlight, while you deliver your talk nice and loud! 

 
□ If you think people are going to take notes: 

o Near the beginning, tell your audience you will Post the slides, and you will have the conference organizer 
email them a link to those slides.  -OR- 

o Make paper handouts of your slides. 
 For PowerPoint, make handouts via File > Print > Print All Slides and Print Layout=Notes Pages 

and Handouts=3 slides or whatever you want. 

 
□ If you have real 3-D meatspace visual aids, awesome. 

o Delegate some minions to demonstrate them! 
 

□ Drawing the audience's attention to a part of your presentation is a GREAT idea. 
o Pointing a laser-pointer at a projection screen is probably fine.  But: 

 Test it first! 

 Don't point your laser-pointer at your 💻 laptop screen — it will bounce off onto the wall behind you.  

:-( 

 If you see laser-pointer on the wall behind the speaker, have them point to real screen instead.  I've 
seen this happen! 

 Don't point laser-pointer at a 📺 TV — it won't reflect. 

o In many of these cases, the PowerPoint laser-pointer will be more effective -- use Ctrl+dragMouse. 

 But to do so, if you are using PowerPoint Presenter View, you will need to see both screens. 
 If you can't see both screens, then you will have to delegate a minion with a stick. 

 If displaying over Zoom, tell PowerPoint to make the laser-pointer much larger!  Test! 
o I have also see a spotlight function used to good effect.  Looks like serious work to add. 

o If your stage has a single display (not two), you can always use a long stick! 
 
 
  

https://www.videolan.org/
https://www.lifewire.com/how-to-take-a-screenshot-on-ios-or-android-2377912
https://www.lifewire.com/best-spelling-and-grammar-check-apps-4176088
https://slideteam.net/blog/create-a-stand-out-slide-highlight-picture-effect
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1.4.1 To scan to a file on our HP OfficeJet Pro 8028 or 8028e all-in-one AI1 AiO 
scanner/copier/printer 

This is according to my experience, and https://support.hp.com/us-en/document/ish_2275901-2074064-16. 
  
[ Digression — before you buy this printer, know that it: 
1. Has ink on a subscription basis, what I call Ink as a Service IaaS.  Not terrible.  Ensure that you select a 

plan that is slightly-over the number of pages you print each month.  If you plan to print a lot one month, the 

month before, bump up your subscription plan.  When done printing a lot, bump it back down.  Sorry. 
2. Will not print double-sided on American legal paper (14"x8½").  Attempting that prints half of the first 

page, and none of the second.  Instead, put in a single sheet of paper, say print single-sided, flip over the 
page yourself, putting it back in the lower tray, optionally with another clean sheet. 

3. Will not scan into a .pdf with text that is searchable, copyable/pasteable.  Nor can I find any way to get 
OCR it after-the-fact, to make it searchable, copyable/pasteable. 

4. Despite being sold as having a "35-Page Auto Document Feeder", I find this unit reliably scan 5 or 10 pages 

in the upper hopper;  more than that jams the lower output hopper.  So stop at 5 or 10 pages, do their 

backsides, then scan another group of 5 or 10 pages, etc.  A bit clunky, but it works! 
5. If you try to print something, and the printer ignores you (usually after you have ignored the printer for a few 

weeks): 
a. If printer and computer are on different Wi-Fi networks [how?], change one so both are on the same network, 

and try again. 

b. If still fail, reboot your printer [how?], and try again. 
c. If still fail, reboot your computer [how?], and try again. 
d. If still fail, run your operating system's printer troubleshooter [how?], and try again. 
e. If still fail, run HP tools [how?] Print and Scan Doctor, then Print Diagnostic Utility, then Network 

Diagnostic Utility, then Hardware Diagnostic Utility. 
□ OK, you have the printer now, back to how to scan … ] 

 

At the printer:  set your original document in the auto-document feeder's upper hopper face-up, or on glass 

facedown against corner with white angle. 
 

On your 💻 computer (if any trouble, https://support.hp.com/us-en/drivers/selfservice/hp-officejet-pro-8020-all-in-

one-printer-series/24208622/model/25479570 > left nav Troubleshooting > HP Print and Scan Doctor) ...  
 
IF you have app HP > HP OfficeJet Pro 8020 Series-HP Scan (this might have been called HP Scan for 
Windows at some point) 

□ Select Windows logo button ⊞Start > All Apps > HP > HP OfficeJet Pro 8020 Series-HP Scan (or might 

have been called HP Scan for Windows at some point) 
□ Left navigation Everyday Scan. 
□ IF you want to scan a photo, 

  set Item Type= Photo, and File Type=PNG (preferably) or JPEG, BMP or TIF, and anything else you need 
ELSE you want to scan a document (something with text),  

  set scan Item Type=Document, and destination File Type=PDF, and anything else you need 
ENDIF 

□ Select button Scan. 
□ When the printer finishes whirring, select More >,  

o If needed, crop by dragging one or more of the eight little grab-boxes. 
o Set Destination, and Manage Images. 
o IF you want to include more scans in this particular file 

   select buttons Add more pages from the scanning device and Scan 

ELSE you are done scanning 
   select buttons Save > Save > Exit 
ENDIF 

 
ELSE you don't have app HP > HP OfficeJet Pro 8020 Series-HP Scan nor HP Scan for Windows  

□ Launch https://support.hp.com/drivers > printer > 8028 > Installation Software and Driver-Includes 
print, scan, latest features, and solutions (2) > : 

o Install HP Easy Start Printer Setup Software (or maybe it was Installation Software and Full/Basic 
Driver-Supports print and scan functionality only — cannot remember) > button Download > launch 
that file > answer all its questions. 

o Reboot. 
o Probably also install HP Print and Scan Doctor for Windows, and reboot again. 
o Go back up to the top of this pseudocode, and use the new app and its superior options. 

https://support.hp.com/us-en/document/ish_2275901-2074064-16
https://support.hp.com/us-en/drivers/selfservice/hp-officejet-pro-8020-all-in-one-printer-series/24208622/model/25479570
https://support.hp.com/us-en/drivers/selfservice/hp-officejet-pro-8020-all-in-one-printer-series/24208622/model/25479570
https://support.hp.com/drivers
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□ If you never could get this app installed … 
 

 IF you are want to scan a photo, AND  
you like better quality and ⅓ the filesize versus the other option, or  

the photo is high quality, or  
you dislike .jpg photo bubbles,  

you should scan with Windows' built-in scanner software (unfortunately, this app was deleted in Windows 11) 

□ Select Windows logo button ⊞Start. 

□ Type scan and wait. 

□ Select app Windows Fax and Scan.  TODO: Did Microsoft kill this off in Windows 11? 
□ Select button New Scan. 
□ Select Profile = 

o Photo (default) if your original is all photo, or 
o Documents if your original is text-only, or text and images,  

except that a few years ago, Microsoft broke this option, and you should use the other paragraph below. 

□ Select File type = 
o PNG (14X size of JPG) or TIF for important photos, or 
o JPG (  1X size of JPG) if you like bubbles photos. 

□ Select Resolution (dpi) = 
o maximum  ◀ for important family-history documents, 

o 1200 (42X size of 150 dpi), 
o   600 (10X size of 150 dpi) (pretty good photo)  ◀ important photos, 

o   300 ( 3X size of 150 dpi) (OK photo), 
o   150 ( 1X size of 150 dpi) (tolerable for a snapshot), 

□ Select button Preview > wait for it to run > crop it. 
□ Select button Scan > wait for it to run. 
□ In the filename pane, select the most recent file > right-click Rename ... and Move to folder ... > etc. 

 
 ELSE you want to scan a (text or mostly-text) document into a .pdf file, you should scan with Windows 11 or 

10 app HP Smart:   
□ TODO:  Test app HP Scan and Capture  

https://microsoft.com/en-us/store/apps/hp-scan-and-capture/9wzdncrfhwl0. 
□ TODO:  Need to bug HP to have https://support.hp.com/us-en/document/ish_6106412-6106481-16 apply to 

this printer? 

□ Select Windows logo button ⊞Start. 

□ Launch app HP Scan for Windows or HP Scan and Capture or HP Smart. 
□ Select button Scan. 
□ Select top-navigation Scan. 

□ Select right-tab icon [gear] > Scan Preset = 
o Document if your original is text-only, or text and images;  or 
o Photo if your original is all-photo, 

except, if you like  
    better quality and ⅓ the filesize, or  

    the photo is high quality, or 
    you dislike .jpg photo bubbles,  

you should instead use the other paragraph above. 
□ If your source document is of a size not listed in the dropdown, check checkbox Detect Edges. 
□ Select Resolution = 

o maximum  ◀ for important family-history documents, 

o 1200 dpi (34X size of 150 dpi) (way more than you need to read text) (scan of photo starts, but 
eventually fails), 

o   600 dpi  (10X size of 150 dpi) (more than you need to read text) (good photo)  ◀ important photos 

until I can get 1200 dpi to work, 
o   300 dpi  ( 3X size of 150 dpi) (extremely good for the finest text) (OK photo), ◀ if OCR to 

searchable/copy-pasteable .pdf, 
o   150 dpi  ( 1X size of 150 dpi) (fine to read any text) (tolerable for a snapshot)  ◀ ordinary docs, 

o     75 dpi (⅓-¼ size of 150 dpi) (tolerable to read most text) (snapshot) smaller filesize, if resolution is OK 

for your intended use. 
□ Select right-tab icon [wand] > button Auto-Enhancements > set Orientation rotate images right-side 

up to On. 
□ Select button Scan. 

o If it says "Scanning was cancelled from the scanner", select buttons OK and Scan. 

https://microsoft.com/en-us/store/apps/hp-scan-and-capture/9wzdncrfhwl0
https://support.hp.com/us-en/document/ish_6106412-6106481-16
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o If it puts the scan file onto Google Drive instead of your SSD/harddrive, try again with a smaller 
Resolution, e.g., 150 dpi instead of 300. 

□ If you see the Detect Edges lines and ¾ circles,: 
o Drag them to edges of your source document (round outward — you can fix it later) > button Apply. 

□ If you need to rotate the scanned page, button Rotate once, twice, or thrice. 
□ If you want to crop, rotate, reflect, brighten, darken, adjust colors, filter, add text or markup your 

scan, select the meatballs button "..." > Edit > do that, perhaps using the right toolbar > select button Done. 
□ If you want to scan more pages into the same document, select button +Add. 
□ If you want to reorder your pages, drag them around — very slowly. 
□ Select button Save (and where), or Share. 

 ENDIF 

ENDIF 
 

□ To control/fix this printer/scanner, use: 
o app HP Smart, 

o app HP Support Assistant, 
o app HP OfficeJet Pro 8020 Series-HP Scan, 

o app  HP Print and Scan Doctor, or 
o embedded web server https://10.0.0.12. 

https://support.hp.com/us-en/document/ish_6106412-6106481-16 
https://123.hp.com/setup 
 
TODO:  Test if the above actions in green will fix … 
  4. How do I get our HP OfficeJet Pro 8028, with app HP Smart scan function Scan Preset=Document, to 

use OCR to create .pdf files with text searchable/copy-pasteable? 
 If can find HP OfficeJet Pro 9010 or 9020, follow https://support.hp.com/us-en/document/c06211157.  
 Need to try steps in https://support.hp.com/us-en/document/ish_6106412-6106481-16. 
 To after-the-fact apply OCR to or compress a .pdf file, see EricPiehl.alterVista.org/tools.pdf#page=20 and 

OmniPage, FineReader or Readiris. 

    Irfanview 32-bit https://FHug.org.uk/kb/link/irfanview-3 will give you text of (A) only a text-block-at-a- 
   time, not the whole doc;  and (B) won't put any text into the .pdf file. 

  5. How do I get our HP OfficeJet Pro 8028, with app HP Smart scan function, to scan a photo with  
Scan Preset=Photo at Resolution=1200 without failing "Scanning was cancelled from the scanner"? 

  6. Consider repeating or linking to this section in EricPiehl.alterVista.org/tools.pdf#page=20. 
 

1.4.1.1 To change ink cartridges on our HP OfficeJet Pro 8028 all-in-one AI1 AiO 
scanner/copier/printer 

To see if you need to replace any ink, at your computer: 

□ ⊞Start > type "printer" > wait > desktop app Printer & scanners. 

□ Select your printer (ours has a name with "HP" and a bunch of dots ".") > button Manage > button Open 

your printer app. 
□ Wait a long time for app HP Smart to launch and find stuff. 
□ See the icons for what the printer thinks of its ink levels — M magenta, C cyan, Y Yellow, and Bk black. 
□ If any are below half-full, see if you have a spare cartridge of that color. 
□ If any are right at the bottom, continue ... 

 
To replace one or more ink cartridges, at the printer:  

□ Close document cover. 
□ Open putty-colored front door. 
□ See "indicated cartridges are ready for replacement". 
□ Remember which ink color icons are shown — one or more of M magenta, C cyan, Y Yellow, and Bk black. 
□ Press button Replace. 

□ Lift open, by the gray plastic handle, simultaneously both the printer top lid with the document cover. 

o If an ink cartridge has a flashing light, it should be the color you noted above. 
o Unclick and remove the empty ink cartridge.  Set aside for later mailing for reuse. 
o Select the proper new ink cartridge. 
o Remove the plastic wrapper, verifying the air vent is now exposed. 
o Snap off the colored cover over the ink exit. 
o Insert the new ink cartridge, pressing all the way back, then down until you year a nice "click". 

□ Lower, by the gray plastic handle, simultaneously both the printer top lid with the document cover. 

https://10.0.0.12/
https://support.hp.com/us-en/document/ish_6106412-6106481-16
https://123.hp.com/setup
https://support.hp.com/us-en/document/c06211157
https://support.hp.com/us-en/document/ish_6106412-6106481-16
https://ericpiehl.altervista.org/tools.pdf#page=20
https://fhug.org.uk/kb/link/irfanview-3
https://ericpiehl.altervista.org/tools.pdf#page=20
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□ After the printer makes noises for a few minutes, it should give you a nice message. 
□ Print! 

□ Can put the empty cartridge in the return envelope for reuse. 
 

1.4.2 To scan to a file on our previous Canon PIXMA MX922 scanner/copier/printer 

□ To scan a photograph to a .png file on our Canon PIXMA MX922: 

o At the printer:  set your original photo in the auto-document feeder's upper hopper face-up, or better yet, 

on the glass facedown. 

o On your 💻 computer: 

 [One-time:  install (from the real Canon support website for the printer) tab Drivers the full "MX920 

series MP Drivers", then …]   

 ⊞Start > Canon Utilities > IJ Scan Utility >  

 button Settings... > tab Photo Scan > set all the options the way you like, including Resolution: 600 
dpi, Data Format: PNG, Save in: somewhere you like, and Open with an application: Windows 

Explorer > button OK >  
 button Photo > wait a minute for the scan to complete > button Exit > wait for File Explorer/This PC 

(formerly Windows Explorer/My Computer), to come up > launch your file, and see if OK. 

 
□ To scan a text-containing document to a .pdf file on our Canon PIXMA MX922: 

o At the printer:  set your original document in the auto-document feeder's upper hopper face-up, or on glass 
facedown. 

o On your 💻 computer: 

 [One-time:  install (from the real Canon support website for the printer) tab Drivers the full "MX920 
series MP Drivers", and install from tab Software "My Image Garden" (this is what makes your scan 
searchable/copy-pasteable), then …] 

 ⊞Start > Canon Utilities > IJ Scan Utility >  

 button Settings... > tab Document Scan > set all the options the way you like, including Data Format: 
PDF (Settings… > check Create a PDF file that supports keyword search > OK), Save in: 
somewhere you like, and Open with an application: Windows Explorer > button OK >  

 button Document > wait a minute for the scan to complete > place next original and click button Scan, 
or click button Exit > wait for File Explorer/This PC (formerly Windows Explorer/My Computer) to come 
up > launch your file, and see if OK. 

 

1.4.3 To scan to a file on our twice-previous HP printer scanner/copier/printer 

□ To have text built searchable/copy-pasteable into your .pdf file on your 💻 computer with an HP printer:  

⊞Start > HP Solution Center > Home > Convert to Text.  Works great. 

 

1.4.4 To scan to a file under ⊞ Microsoft Windows 

□ How to scan a document in Windows (for me, see previous section!). 
 

1.4.5 To copy a file from an Android phone to a computer 

NEW There are other methods.  I find this easiest: 
□ Connect a cable from your phone to your computer. 

o For a Google Pixel 4, use a USB-A to USB-C cable. 
□ On your phone, unlock, and swipe down to see notifications.  Find notification "USB for file transfer" (if 

necessary, scroll down through the notifications) > "Tap for other USB options." > 
o "USB controlled by"="This device", 

o "Use USB for"="Transferring files", and 

o "Trancode exported video" "Convert HEVC videos to AVC format so you can play them on your computer 
and other devices." = On. 

□ ⊞💻 On your Windows computer, launch ⊞Start > app File Explorer/This PC [formerly Windows 

Explorer/My Computer, and still called Windows Explorer under-the-covers] > see your phone as a 

sorta-diskdrive > select it > Internal Memory > DCIM > move pics to the correct permanent location on 

your computer, then rename or otherwise process them. 
□ When done, disconnect the cable and return to its permanent location. 

https://www.lifewire.com/how-to-scan-a-document-in-windows-4153030
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1.4.6 To copy or move a file from a camera to a computer 

NEW There are other methods, including setting up automated software to looks look for cameras connected via a 
cable, and fighting over which automated software that will be, and where they put the phones. 
 
I find this method easier: 

□ Do not connect any cable from your camera to your computer! 
□ On your camera, slide open the cover, push in the SD card with fingernail, release, and then pull out the SC 

card. 

□ On your 💻 computer, insert SD card in the built-in slot, or into an adapter (if needed, remove existing card). 

□ ⊞💻 On your Windows computer, launch ⊞Start > app File Explorer/This PC [formerly Windows 

Explorer/My Computer, and still called Windows Explorer under-the-covers] > see the new sorta-

diskdrive > select it > DCIM > camera > [possible subfolder >] move pics to the correct permanent location 
on your computer, then rename or otherwise process them. 

□ When done, replace the SD card in the camera. 
 

1.4.7 If you are going to show web link URLs or URIs 

If you are going to show or print any web links,  
  be kind to your audience,  
  by making it possible to write down or type your URL,  
  by shortening the URL by: 
 

□ Make sure the URL works, by Pasting it into a browser tab or ⊞Win+R box > [Enter]. 

If bad, get it working, using your favorite Search Engine (e.g., Search engine DuckDuckGo), or other means. 
 

□ If a page exists that already has the links you have, such as someone's resource page, link to that page. 
(May take care of multiple URL.  And may offload to them maintaining those web addresses!) 

 
□ For your super-problem URLs, consider using a URL-shortener service, such as https://bit.ly and 

https://tinyurl.com. 
 

□ For links to Search, use format: 
o https://duckduckgo.com/?q=windows+10+sort+folders+top 
o https://google.com/search?q=windows+sort+folders+top 

Test the new URL. 

If bad, undo this this change. 
If good, use this URL — you are done. 

 

□ For links to maps, weather, flight info or YouTube, see formats in my tools document page 2 or 3. 
Test the new URL. 
If bad, undo this this change. 
If good, use this URL — you are done. 

 
□ If the URL starts with "https://www.", replace it with "https://". 

If the URL starts with "http://www.", replace it with "http://" or with "www." (your choice), or (because of 

the below) "". 
(Most webmasters set up their domain stuff so either works, so no need to have humans look at the extra text, 
nor type it.) 
Test the new URL. 
If bad, undo this this change. 

 

https://en.wikipedia.org/wiki/URL
https://duckduckgo.com/
https://bit.ly/
https://tinyurl.com/
https://duckduckgo.com/?q=windows+10+sort+folders+top
https://google.com/search?q=windows+sort+folders+top
http://ericpiehl.altervista.org/tools.pdf#page=2
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□ If the URL contains 
"facebook.com/pg/pagename", remove the 

"pg/". 

If the URL contains 
"facebook.com/groups/pagename", remove the 

"groups/". 

(Nether are needed [thank you webmaster!], so no 
need to have humans look at the extra text, nor 
type it.) 
In general, this should be something like 
"https://facebook.com/pagename", where 

"pagename" is the Facebook "@name" (without the 

"@") displayed on all of your group's Facebook 

pages. 
Test the new URL. 

If bad, undo this this change. 
□ If the URL contains "google.com/", you can try 

replacing it with "g.co/" or "google/" (try both). 

Test the new URLs. 
If bad, undo this this change. 

□ If the URL contains "youtube.com/watch?v=", 

replace it with: 
   "youtu.be/" (if audience needs video 

Description, 👍Thumbs Up, Subscribe or 🔔 

notification bell);  or 
   "youtube.com/embed/" (if audience does not 

need to see video Description, 👍Thumbs Up, 

Subscribe nor 🔔 notification bell). 

In general, this should be something like 
"https://youtu.be/videoname" or 

"https://youtube.com/embed/videoname", 

where "videoname" is the 11-character video 

identifier. 
Test the new URLs. 
If bad, undo this this change. 
To publicize/promote, include relevant parts of:   
o "For full effect, select the video link, then icons ⛶ fullscreen, ㏄ captions, ▶ Play, and ⛶ ☒ Skip Ads. 

 If no captions are available, you can get captions from browser Edge (⊞Win+Ctrl+L) (and Chrome?), 

even if you are watching the video in another browser! 
 ⊞ Under Microsoft Windows, see https://support.microsoft.com/en-us/windows/use-live-captions-to-

better-understand-audio-b52da59c-14b8-4031-aeeb-f6a47e6055df#bkmk_turnoncaptions. 
o "For additional reading, see links under button ...more.  (Was Description under button SHOW MORE). 

o "If you like what you see, give our video a 👍Thumbs Up, and Share. 

o "If you want to see more videos like this, Subscribe, and ring the 🔔 notification bell.  And see our 

YouTube channel https://youtube.com/WildOnesRiverCityGrandRapidsAreaChapter/videos."  (Was 
https://youtube.com/channel/UCgLyuz9Ws3_pcodpiwKVRCg/videos.) 
Or my son's https://youtube.com/channel/UCcdVkcu8_YxWhoPz4IF44OQ/videos.  When Andy's YouTube 
channel grows to 100 subscribers, we can dramatically-shorten the URL to  
  https://youtube.com/AndrewPiehl/videos or  

  https://youtube.com/c/AndrewPiehl/videos,  
as is currently done by 
  https://youtube.com/WildOnesNativePlants/videos and  
  https://youtube.com/c/WildOnesNativePlants/videos, and  

  https://youtube.com/MissouriPrairie/videos and  
  https://youtube.com/c/MissouriPrairie/videos,  

according to https://support.google.com/youtube/answer/2657968. 
□ If the URL contains "youtube.com/c" or "youtube.com/channel" or "youtube.com/user",  

replace it with "youtube.com" or "youtube.com/c". 

In general, this should be something like "https://youtube.com/channelname" or 

"https://youtube.com/c/channelname", where "channelname" is the YouTube channel's name. 

https://support.microsoft.com/en-us/windows/use-live-captions-to-better-understand-audio-b52da59c-14b8-4031-aeeb-f6a47e6055df#bkmk_turnoncaptions
https://support.microsoft.com/en-us/windows/use-live-captions-to-better-understand-audio-b52da59c-14b8-4031-aeeb-f6a47e6055df#bkmk_turnoncaptions
https://youtube.com/WildOnesRiverCityGrandRapidsAreaChapter/videos
https://youtube.com/channel/UCgLyuz9Ws3_pcodpiwKVRCg
https://www.youtube.com/channel/UCcdVkcu8_YxWhoPz4IF44OQ/videos
https://youtube.com/WildOnesNativePlants/videos
https://youtube.com/c/WildOnesNativePlants/videos
https://youtube.com/MissouriPrairie/videos
https://youtube.com/c/MissouriPrairie/videos
https://support.google.com/youtube/answer/2657968
https://www.gocomics.com/doonesbury/2022/02/20
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In general, this should be something like "https://youtube.com/username" or 

"https://youtube.com/user/username", where "username" is the YouTube user's name. 

Consider navigating straight to the videos as in "https://youtube.com/channelname/videos" or 

"https://youtube.com/c/channelname/videos". 

Test the new URL. 
If bad, undo this this change. 

□ If the URL contains "naturenearby.org/portfolio_page/explore/", remove the 

"portfolio_page/explore/". 

If the URL contains "naturenearby.org/explore/", remove the " explore/". 

(Nether are needed [thank you webmaster!], so no need to have humans look at the extra text, nor type it.) 
In general, this should be something like "https://naturenearby.org/preserve", where "preserve" is 

the name of the preserve. 
Test the new URL. 
If bad, undo this this change. 

□ If the URL contains "https://rivercitygrandrapids.wildones.org", change the 

"https://rivercitygrandrapids." to "http://rivercity" or "www.rivercity" or (because of the 

below) "rivercity". 

Test the new URL. 
If bad, undo this this change. 

□ If the URL contains "rivercitygrandrapids.wildones.org", remove the "grandrapids.". 

Test the new URL. 
If bad, undo this this change. 

□ If the URL contains "https://nbcnews.com", use that page's link "SHARE LINK ... </>" to get an 

embedded link such as "https://nbcnews.com/news/embedded-video/mmvo86989381934". 

Test the new URL. 

If bad, undo this this change. 
□ If the URL contains or ends in: 

o "/index.html" 

o "/index.htm" 

o "/index.shtml" 

o "/index.asp" 

o "/index.aspx" 

o "/index.jsp" 

o "/index.php" 

o "/default.html" 

o "/default.htm" 

o "/default.shtml" 

o "/default.asp" 

o "/default.aspx" 

o "/default.jsp" 

o "/default.php" 

o "/home.html" 

o "/home.htm" 

o "/home.shtml" 

o "/home.asp" 

o "/home.aspx" 

o "/home.jsp" 

o "/home.php" 

replace it with "". 
(The site's web server will try many of these by default, so no need to have humans look at the extra text, 
nor type it.) 

Test the new URL. 

If bad, undo this this change. 
□ If the URL ends in "?ref=page_internal", replace it with "". 

(Useless, so no need to have humans look at the extra text, nor type it.) 
Test the new URL. 
If bad, undo this this change. 

□ If the URL contains/ends in a parameter delimited by "?", and perhaps additional parameters delimited by "&",  

  start removing the parameters, one at a time. 
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(Many of these parameters may not be needed, so no need to have humans look at the extra text, nor type it.) 
I suggest starting at the end, and moving forward. 
When removing a parameter, always remove its starting delimiter, "?" or "&".   

  Do not remove its ending delimiter. 
If you remove the first parameter with its starting delimiter "?", replace the next delimiter "&" with "?". 

If you remove a subsequent parameter with its starting delimiter "&", that is fine. 

Test the new URL. 
If bad, undo this this change. 
Continue with the other parameters. 

□ If the URL ends in: 
o ".html" 

o ".htm" 

o ".shtml" 

o ".asp" 

o ".aspx" 

o ".jsp" 

o ".php" 

o "/" 

replace it with "". 
(The technology needs it there, but will correct it in a few microseconds, so no need to have humans look at 
the extra text, nor type it.) 
Test the new URL. 
If bad, undo this this change. 

□ If the URL starts with "http://" or "www.", replace it with "". 

In a browser tab, this will work fine.  But test it anyway. 

In a ⊞Win+R box, this will break the URL.  But any audience member who launches websites this way, will 

know to add it back. 

□ If you wish, add readability to your URL, by changing the case of your URL's domain name — the 
subdomain, hostname, and top-level domain between the "//" and the following "/".  That part is not case-

sensitive, so you can cHAngE ItS cASe as you wish.  (Whether the rest of the URL is case-sensitive depends on 
your web server software, and perhaps the operating system upon which it runs.) 
For example, change  
   from "https://nbcnews.com/news/e..."  

       to "https://NBCnews.com/news/e..." or  

           "https://NbcNews.com/news/e..." using UpperCamelCase. 

Test the new URL.  It will work fine if you typed it right. 
If bad, undo this this change.  Then correct how you mistyped it, and try it again. 
o This works with email addresses, too.  The entire address — the local-part, "@", and the domain. 

 

□ For your super-problem URLs, consider using a URL-shortener service, such as https://bit.ly and 

https://tinyurl.com. 
 

□ To send these URLs/URIs to 📱 mobile smartphones, consider email. 

o If you need to send these URLs/URIs via SMS or MMS text messages, see 
https://wikipedia.org/wiki/SMS_gateway#Email_clients or https://wiktel.com/texting.php.  I also have code 
that does that programmatically--from code.  Either way, you have to determine their mobile provider 
company;  you can do up to five requests for this free from 
https://realphonevalidation.com/resources/phone-carrier-lookup. 

 

1.5 Internet access 

□ Do not trust that your site will have Internet access: 

o At AY_ CM, they have Wi-Fi only in the more-common conference rooms, for which we can sometimes 

drag credentials out of the staff, or figure out for ourselves.  One room I know of has wired Internet, which 
I used once to download a file to a flash-drive/jumpdrive/thumbdrive/USB-attached SSD/USB-drive/USB-
key/USB-stick.  The presenter (who had expected good Internet access) talked without visuals for the first 
third of the talk, until I had connected to the Internet, downloaded to a thumb-drive, and sneaker-netted it 
across the room.  

o At C_ (MCLH, B_C and elsewhere), they have wired Internet, and Wi-Fi with a complicated sign-on process 
that you must repeat every 3 weeks. 

https://wikipedia.org/wiki/Camel_case
https://bit.ly/
https://tinyurl.com/
https://en.wikipedia.org/wiki/SMS_gateway#Email_clients
https://wiktel.com/texting.php
https://realphonevalidation.com/resources/phone-carrier-lookup
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o DVP has Wi-Fi, but they won't let us use it. 
o SLC now has open Wi-Fi. 

o _Q has Wi-Fi, open or encrypted. 
 

□ If you want to save a video from Facebook. 
 

□ If you want to use a video on YouTube, see if the page has a Download button. 
o If Yes, press it, and save it to a known filename and location. 
o If No and you are a close friend of me, please let me know, I will walk you through my tools document. 

 
□ If you want to use a website, or want to use a .pdf and your presentation software wont import that: 

o Do some print-screens.  Bring it up on your largest screen, zoomed in as much as you can. 
 ⊞ Under Microsoft Windows, do one of: 

 ⊞Start > type "snip" > wait > desktop app Snipping Tool > New > mouse drag rectangle you 

want > Exit > Save=Yes > to .png or .tiff format (lossless!), not .jpg (lossy!). 

 ⊞Win+Shift+S > choose a shape > drag your area > do something with your results in the 

Clipboard or Notification. 

-OR- 
o Save off a working copy of the website (I know some ways of doing that). 
o Import that into your presentation. 

 

1.6 Test it! 

□ If you think you can run without access to the Internet, turn off your Internet access, show your presentation, 

and verify that you can see all photos, videos and 🔊 audio, with no hovertext! 

 
□ Verify that videos and presentations always show ⛶ fullscreen, without taskbar, volume level nor other 

overhead.  Don't distract your audience. 
o For .pdf, use Ctrl+L, or View > Full Screen Mode. 

o For .ppt and .pptx, use F5, or Slide Show > From Beginning. 

 If MS PowerPoint 2010 will not play a video or shows "Media Unavailable": 

 Install the latest version of the 🍎 Apple QuickTime player > "OK" "Help", click OK. 

 Set app QuickTime > Edit > Preferences > Player Preferences > uncheck checkbox "Show 
Content Guide at startup, as in https://discussions.apple.com/thread/8527642. 

 Restart PowerPoint and then try playing the video slide again. 
 Make a note to, after you are done with this project, uninstall the app, and do the rest of what the 

message says. 
o For .key, use ___? 

o For video files, your media player should have a ⛶ Fullscreen button or View > Fullscreen. 
o If you any issues with your current media player, install VLC media player from VideoLAN.  I love it!  

Plays all kinds of files, tolerates incomplete or damaged media files, records played media, converts 
between file types, and grabs individual-frame screenshots.  [To take a cellphone mobile screenshot.] 

 
□ Verify that your presentation covers Why before How before What, as in TED talk "Start with Why" by Simon 

Sinek or TED talk "Start with Why" by Simon Sinek. 
 

□ Spellcheck everything! 
 

□ If you have speaker notes, print them off, and put the 📄 paper copy in your presentation kit. 

o If any technology problems, you can hold them in your hand, and speak with confidence. 
 

□ Save off a safety copy of your presentation in .pdf format. 

o Under Microsoft PowerPoint, File > Save As > .pdf.  This method makes the file searchable/copy-

pasteable! 
o If your presentation software starts fighting with your videoconference software (it will, someday!), you 

can show your audience the .pdf! 

 Test this with your videoconference software! 
o If presenting to a live audience, consider printing off these slides, too. 

 If you have a total power failure, have an assistant hold up your 📄 paper slides illuminated with a 

mobile-phone flashlight, while you deliver your talk nice and loud! 
 

https://www.lifewire.com/save-videos-from-facebook-4155583
http://ericpiehl.altervista.org/tools.pdf
https://support.apple.com/downloads/quicktime
https://discussions.apple.com/thread/8527642
https://www.videolan.org/
https://www.lifewire.com/how-to-take-a-screenshot-on-ios-or-android-2377912
https://www.ted.com/search?q=Simon+Sinek
https://www.ted.com/search?q=Simon+Sinek
https://youtube.com/embed/sioZd3AxmnE
https://www.lifewire.com/best-spelling-and-grammar-check-apps-4176088


 
EricPiehl.alterVista.org/present.pdf  2024-03-28                      page 30 

□ Save off a safety copy of your presentation in a format runnable on someone else's machine. 
o If your presentation is a .ppt or .pptx, also save it with the PowerPoint runtime by File > Save As 

.pps or .ppsx.   

 If your 💻 computer should die, it should be showable on someone else's computer without PowerPoint 

(not sure what operating systems are supported). 
 

□ If at all possible, put all your content, in all those file formats, on: 

o Your 💻 computer SSD/harddrive (preferably all together as sister-files in the same folder, and know 

where that folder is). 
-AND-  

o A flash-drive/jumpdrive/thumbdrive/USB-attached SSD/USB-drive/USB-key/USB-stick (and 
know where that is). 

    -AND-  

o Any location knowable by your presentation site, such as their shared network drive, 🍎 Apple iCloud, 

Google Drive, Microsoft OneDrive, Box, Dropbox, pCloud;  or the more-secure milDrive, sync.com or 

SpiderOak ONE ($);  or other file hosting, file synchronization, or online backup services. 
 

□ When you acquire a new flash-drive/jumpdrive/thumbdrive/USB-attached SSD/USB-drive/USB-
key/USB-stick: 
o IF your drive came in format="FAT32",  

   AND you want your drive to handle file sizes >4GB=No,  
THEN you can leave it just like this. 

o IF your drive came in format="NTFS",  

   AND you want your drive for ⊞ Microsoft Windows use=Read-Write  

   AND 🍎 Apple macOS use=Read-Only or not at all,  

THEN you can leave it just like this. 
o IF your drive came in format="HFS+",  

   AND you want your drive for 🍎 Apple macOS use=Read-Write  

   AND ⊞ Microsoft Windows use=not at all,  

THEN you can leave it just like this. 
o IF you want your drive for use in the Honda Fit/Jazz Type 2 entertainment system,  

THEN reformat your drive to format="FAT32". 

o 🍎 IF you are running Apple macOS level lower than 10.6.6,  

THEN apply the "exFAT patch". 

o IF you are running ⊞ Microsoft Windows release lower than 7,  

THEN apply the "exFAT patch". 

o IF you are running ⊞ Microsoft Windows release lower than 10,  

THEN upgrade to a modern level of ⊞ Microsoft Windows with all due speed. 

o IF you want your drive for 🍎 Apple macOS use=Read-Write, 

   AND/OR ⊞ Microsoft Windows use=Read-Write,  

   AND/OR handle file sizes >4GB=Yes,  
THEN reformat your drive to format="exFAT" as in 

https://support.wdc.com/knowledgebase/answer.aspx?ID=291 (creates folder "__MACOSX"). 

□ While you are at it, personalize the name of your flash-drive/jumpdrive/thumbdrive/USB-attached 
SSD/USB-drive/USB-key/USB-stick to: 
o something with your name and location, in format FirstLastUSA, or 

o a permanently-available 📱☎ phone number, in format  AAA-EEE-NNNN. 

 
□ If collaborating with a distributed team, please do in a shared workspace using: 
o Google Docs, Sheets and Slides, running on Google Drive, very good, free.  If you have a Gmail email 

account, you already have access to Google Docs, Sheets and Slides through your email account.  Spaces.  
Forms.  Drawings (Visio). 

o Microsoft Office Online, running on Microsoft OneDrive.  If you have an Outlook.com/Live Mail 

(formerly Hotmail) email account, you already have access to Microsoft OneDrive and Office Online 
through your email account. 

o Comparison of above two. 
o Or share folders or files with your team via Dropbox (Basic plan FREE) (I love this, and use all the time!), 

🍎 Apple iCloud, Box, pCloud;  or the more-secure milDrive, sync.com or SpiderOak ONE ($);  or 

other file hosting, file synchronization, or online backup services. 
If using Dropbox as your collaboration tool, tell your team ... 

https://wikipedia.org/wiki/Comparison_of_file_hosting_services
https://wikipedia.org/wiki/Comparison_of_file_synchronization_software
https://wikipedia.org/wiki/Comparison_of_online_backup_services
https://support.wdc.com/knowledgebase/answer.aspx?ID=291
https://get.google.com/spaces
https://google.ca/forms/about/
https://www.lifewire.com/google-drive-review-1356570
https://wikipedia.org/wiki/Comparison_of_file_hosting_services
https://wikipedia.org/wiki/Comparison_of_file_synchronization_software
https://wikipedia.org/wiki/Comparison_of_online_backup_services
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 To see the full PowerPoint presentation (with script, etc.), 

on a 💻 computer with real Microsoft Office 2007 and above,  

launch the file from within: 
 ⊞ Microsoft Windows File Explorer/This PC (formerly Windows Explorer/My Computer), or 

 the new (2019-10-17/27?) Windows App "Dropbox".  Can launch this by, in the Notification 
Area (will be Action Center in Win10X) (formerly System Tray) (by the clock): 
o double-click icon, or 

o single-click icon Dropbox > icon folder. 
 To see a cripple-ware version of the PowerPoint presentation, 

from any 💻 computer (▯ tablet?) (📱 smartphone?),  

launch the file from within a web browser interface.  Can launch this by, in the Notification Area (will 
be Action Center in Win10X) (formerly System Tray) (by the clock): 

o single-click icon Dropbox > icon world. 
 

□ If you have real 3-D meatspace visual aids, awesome.  Delegate some minions to demonstrate them! 

 

 
  



 
EricPiehl.alterVista.org/present.pdf  2024-03-28                      page 32 

2 Kit 
□ You probably want to make a kit of stuff to bring.  Some ideas: 

 
□ L's kit (in ___): 

o 💻 Computer with DVI port, DVI/VGA adapter, powercord, this document printed on dead trees. 

 
□ M's kit (in his/her computer bag): 

o 💻 Computer with HDMI port, in a case, with powercord, mouse and HDMI cable.  

o HDMI/VGA adapter. 

o 📽 Projector in case, with power cable, VGA cable, and wireless presentation-clicker(-remote-

control)/laser-pointer. 
o Bag with extension cord, power strip, external speakers including power cable and headphone cable. 

 
□ My kit (in my briefcase in a magic blue box "Tardis"): 

o 💻 Computer with HDMI port, in backpack with powercord. 

The backpack also contains, all nice and neat in a blue pencil box I call my TARDIS . . . 
o HDMI/VGA adapter.  I have used, successfully, a reverse VGA/HDMI adapter. 

o North-American-outlet splitter (can charge or run two or three devices from a single outlet). 
o North-American-outlet/USB-A adapter (to charge two devices that do so over USB-A cables). 
o Car-outlet/USB-A adapter (to charge devices that do so over USB-A cables). 

o USB-C/🍎 Apple Lighting/USB-A /micro-USB/SD-card/µSD-card adapter (connects most modern [2019+] 

📱 smartphones to a 💻 computer or Square credit card device or charger).  

 [If an ubergeek asks about micro-A vs. micro-B, get the micro-B.] 

o USB-A/micro-USB cable (connects most Android and WP to 💻 computers or charger). 

 [If an ubergeek asks about micro-A vs. micro-B, get the micro-B.] 

o USB-A/mini-USB cable (connects [past-tense?] most cameras to 💻 computers). 

o Small Wi-Fi router/range-extender/public-hotspot-firewall (NETGEAR Trek N300 PR2000), connectors 

below. 
o Small Ethernet "Cat-5" cable (for wired Internet, if needed). 

o Chromecast device, with extender and powercord, if I made a note to remove from our 📺 TV and bring it. 

o Two or more flash-drive/jumpdrive/thumbdrive/USB-attached SSD/USB-drive/USB-key/USB-sticks (for 
people who forgot one). 

o Battery pack (to run or slowly charge mobile cellphones when away from grid and car power-outlets). 
o Disposable batteries (AA×4, AAA×3, ha). 
o Bag of zip-ties, string, paperclip, etc. 
o Small cheap headphones, extender cable, 6.35 mm/3½ mm adapter, RCA phono/3½ mm adapter. 

o 🎤 Microphone with 3½ mm male TRS (not TS) plug (with little shirt clip) [+ headphone extender cable]. 

o USB-A/external stereo sound adapter dongle [+ USB-A extender cable]. 
 

□ If you are going to buy a 📽 projector: 

o Get one that projects: 
 Full HD 1080p (1920x1080 at 16:9),  

          WUXGA (1920x1200 at 16:10),  

 4K (UHDTV1) (3840 × 2160 at 16:9),  

 8K (UHDTV2) (7680 × 4320 at 16:9), or 

 better. 
I am told the Epson 1980WU was great for larger venues. 

o Unless budget drives it, try not to get an ancient one that projects just HD 720p (1280x720 at 16:9 or 

1280x800 at 16:10)--that has only 44% of the pixels above.  Nor worse.  I am told the Epson 1771W 

works well on screens up to 6 m (20 ft) wide. 
o HDMI or wireless input is more important than VGA or DVI.  I saw one workplace where people connect 

wirelessly to their 📽 projector, apparently via a Chromecast or similar app and device. 

 ⊞ But under Microsoft Windows, that does not allow you to see your speaker notes using PowerPoint 

Presenter View.  Nor see to mouse over your presentation.  TODO:  Using Google Slides? 

 

  

https://smile.amazon.com/gp/product/B002ODG5GO
https://smile.amazon.com/gp/product/B00E717OXE/
https://smile.amazon.com/gp/product/B00E717OXE/
https://smile.amazon.com/gp/product/B01H5BOLYC/
https://smile.amazon.com/gp/product/B00HQ883T4/
https://smile.amazon.com/gp/product/B00OJ5AV8I/
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3 If you want to 📹 / 📱▯💻 pre-record your presentation 
□ You might want to capture your voice over video scraped from your 💻 computer, stored in a video file;  

a file which you can later: 
o play for others (beforehand, test on your favorite media players), 
o share with others via a shared folder, 
o share with others on Facebook, 

o post or embed on a website, 
o embed into an email using Mail Chimp or other emailer, 
o upload to YouTube, or 
o use as part of a later meeting/videoconference/webinar. 

 
□ [Presenters]  If you are recording at home of the office, locate a standing desk;  or a regular desk with your 

💻 laptop elevated by a box or stack of books. 

o Doing so, your voice will project better. 

o And if you are a bit congested, minimize any fluids in your lungs. 
 

3.1 Ways to record and edit your video 

3.1.1 Method A [recommended]:  Record in a real studio 

□ [Presenters]  Arrange a tour of your local library's podcast studio (and for presentation day, make a 
reservation -- under COVID-19, only one reservation per day!).  Ours has: 
o a soundproof room with a Internet, phone, table, 4 chairs, instructions, 

o 3 🎙🎤 professional microphones and closed-back headphones, connected to a ... 

o RØDECaster Pro audio mixing console (mixing board) https://rode.com/rodecasterpro, which can store 
audio recordings on a microSD (μSD microSDHC microSDXC microSDUC TF) card, and optionally transmit it 

over a USB-A/USB-C cable to a ... 
o laptop running ... 
o RØDECaster Pro Podcast Studio software (to configure something, and one way to get your recording 

off the mixing board), and 

o Adobe Audition 2020 software (to edit your 🔊 audio recording or podcast). 

 13 Reasonable Alternatives to Adobe's Expensive Apps. 

o Instructions and signup are at https://kdl.org/podcast.  Under the COVID-19 coronavirus pandemic, 
they only allow one signup per day, so you might as well reserve it all day! 
Hours https://kdl.org/locations/ADA.  Questions "Penni Zurgable (PZurgable@kdl.org)". 

o I made a test audio recording and transferred it to my computer.  Way cool! 
o Need to verify that I can fix soft recording level, by adjusting mixer board's Output-level slider. 

o Need to determine how to feed podcast studio's 🔊 good audio into a Zoom presentation, or a 📹 video 

recording of someone showing and doing stuff on a computer.  Presumably from the mixer's Audio Outs, 

into a computer, using some combination of cables and connectors. 

o May practice editing an 🔊 audio recording using the podcast studio's Adobe Audition 2020 software. 

 13 Reasonable Alternatives to Adobe's Expensive Apps. 
o Need to determine a way to,  

  while people are waiting for a Zoom presentation to start,  

  while sharing a nice slide with the name and subject of the presentation and that it will start soon, 
  have neither silence nor the panelists talking among themselves,  

  but have some 🔊 music or nature sounds, 

  so that people know their 🔊 audio is working. 

This is regardless of using a podcast studio or not. 

This ought to work, but it doesn't:  On slide-sharing computer > launch presentation with intro slide with 
the name and subject of the presentation and that the presentation will start soon > launch audio > launch 
Zoom > button "Share Screen" > check checkbox "Share sound" > select the window with the intro slide > 

button "Share" > verify slide and audio are visible and audible over Zoom.  The slide is visible, but the audio 
is not.  Does the audio have to be embedded in the slide? 

3.1.2 Method B [recommended]:  Record on your computer, using your OS 

□ [Presenters]  General purpose method to capture your voice over video scraped from your presentation, 
or any other screen or window or browser tab, under Windows 10 (now that I am using Windows 11, I 
should try the updated Windows Snipping tool): 

https://smallbusiness.chron.com/powerpoint-facebook-39772.html
https://www.ikea.com/us/en/search/products/?q=standing+desk
https://rode.com/rodecasterpro
https://lifehacker.com/13-reasonable-alternatives-to-adobes-expensive-apps-1846699369
https://kdl.org/podcast
https://kdl.org/locations/ADA
mailto:PZurgable@kdl.org)
https://lifehacker.com/13-reasonable-alternatives-to-adobes-expensive-apps-1846699369
https://www.pcmag.com/how-to/how-to-capture-video-clips-in-windows-10
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o [one-time] Allow 🎤 microphone to be accessed by app Xbox Game bar, via ⊞Start > type "captures" > 

select Captures settings > turn On Record audio when I record a game. 

o Setup to do your presentation, and get your presentation in focus (become the active window). 

o ⊞Win+G game bar. 

o Set it set to record 🔊 audio from your presentation, and your 🎤 microphone, via in Audio pane: 

 set your 🎤 microphone all the way up, 

 your presentation all the way up. 

 Try to leave alone everything else.  If you mute something, and if you ever want to hear that 🔊 audio 

source ever again, make a note to later come back here and turn it back on. 

o If your presentation contains its own 🔊 audio, or video with 🔊 audio, make a short test run, to see if you 

get an echo.  We did, I assume , caused by the 🔊 audio being scraped for the output file, also sent to your 

speakers, which goes to your ears and also your 🎤 microphone, where it is then scripted again for the 

output file.  

 Try wearing a 🎤🔊 headset, so your 🎤 microphone can't hear what is coming from the speakers. 

 During the 🔊 audio, or video with 🔊 audio, experiment with muting your 🎤 microphone.  Ours 

experience is that doing so helps a bit. 
o Make short test run, to make sure everything is set up right. 
o When ready, continue &hellip; 

o Start recording using ⊞Win+Alt+R. 

Wait for a few seconds until the little Record icon comes up. 
o Give your presentation, talking as you go.  No Pause button, but there is a Mute button. 

o When done, click button Stop, or ⊞Win+Alt+R, start/stop recording. 

o Verify your recording is OK in ⊞Win+G > in Capture pane, select Show all captures > in Gallery pane, 

select your recording > button Play. 
o I got this as an .mp4 file.  Which you could change to a .wmv if you had to -- see my tools document. 

o If OK, you can locate the file by selecting the icon that looks like a Folder "Open in File Explorer", or in 
"C:\Users\yourLogonName\Videos\Captures". 

o If you have 1.2 seconds of noise at the beginning, trim it as in my tools document. 
 

□ TODO:  Look into tool SnagIt. 

3.1.3 Method C [unknown]:  Record on your computer, using your chip's software 

[Presenters] 
□ Apparently, users of machines with Intel chips can also record their screens using app Intel Graphics 

Command Center > tab Capture. 

o I have not yet tried this method.  Next time I need to record a presentation, I may try it. 
o You might have to install this via app Intel Driver & Support Assistant — I don't remember. 

 
□ I wonder if AMD or other chip manufacturers have a similar function. 

3.1.4 Method D [dis-recommended!]:  PowerPoint 2010 

[Presenters] 
□ I heard that you can record presentations within Microsoft PowerPoint 2016: 

o File > Export > Create a Video > Create a Video. 
 If you want to change the video quality, change the added narrations or time spent on each slide, you 

can tweak those settings here. 
 Save > let it run. 

 

□ I heard that on a newer 💻 computer,  

o File > Convert (below Save) > convert to MP4 > let it run. 
 

□ On my MS PowerPoint 2010, I can: 

o File > Save As > Windows Media Video (.wmv) > Save > let it run.  And Test.  
Seemed to just record my voice, breaking it up per slide, putting that slide's portion on that slide, and not 
recording during slide transitions.  Not what I wanted. 
Plays my presentation, but very fixed. 
Seems to what I read in How to Link PowerPoint to Facebook. 

o File > Save & Send > Create a Video > Record Timings and Narration > do that, X when done > Use 
Recorded Timings and Narration > Create Video > let it run.  And Test.  
Seemed to just record my voice, breaking it up per slide, putting that slide's portion on that slide, and not 

http://ericpiehl.altervista.org/tools.pdf
http://ericpiehl.altervista.org/tools.pdf#page=15
https://www.techsmith.com/tutorial-snagit-recording-video.html
https://smallbusiness.chron.com/powerpoint-facebook-39772.html
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recording during slide transitions.  Not what I wanted. 
Plays my presentation, but very fixed. 

 
□ Use your saved video as in the beginning of this section. 

□ But in testing, I found these to: 
o When I play the video file, my voice is all muddy. 
o My voice entirely cuts out several seconds before and after each slide transition. 

□ Neither of which happens with the more general method. 
 

3.2 Post video so people can see it 

3.2.1 Post video on your own website 

□ See your webmaster for details! 

o You are probably going to: 

 upload your video to your web host, and 
 modify or add a webpage to run that file in a player. 

o Perhaps tell the search engines about your new content. 

3.2.2 Stream on, or upload video, to YouTube 

□ Start a YouTube channel, perhaps Type="Brand Account", whatever that is.  (The alternative to "channel" 

is "user".) 
o With a good Name. 
o And good Keywords.  Can change later at the YouTube channel dashboard https://studio.youtube.com > 

tab "Settings" > tab "Channel" > subtab "Basic info". 
o And good Associated website.  Can change later at the YouTube channel dashboard 

https://studio.youtube.com > tab "Settings" > tab "Channel" > subtab "Advanced settings" > link 

"Advanced channel settings". 

o ____ at https://youtube.com/channel or 
https://youtube.com/WildOnesRiverCityGrandRapidsAreaChapter/videos (was 
https://youtube.com/channel/UCgLyuz9Ws3_pcodpiwKVRCg/videos). 

o Controlled via https://aboutme.google.com or https://aboutme.google.com/b/100004028594510235191. 
o Photos at https://photos.google.com/b/100004028594510235191. 
o Link to other groups. 

o We can set a "video watermark" to our content in the YouTube channel dashboard 
https://studio.youtube.com > tab "Settings" > tab "Channel" > subtab "Branding". 

o If we have a "Google Analytics property tracking ID", we can set it in the YouTube channel dashboard 
https://studio.youtube.com > tab "Settings" > tab "Channel" > subtab "Advanced settings" > link 
"Advanced channel settings". 

 

□ Upload a video to YouTube. 

o Set video details, including "tags" and Description, at YouTube channel dashboard 
https://studio.youtube.com > tab "Videos" > select our video > pencil icon "Details". 

o If you misspeak, e.g., pronouncing "million" as "billion", even if you find it later, you can use YouTube 
editor to add a correction text box saying "million, not billion" for about 10 seconds, at the time of the 
error.  I see this all the time in videos posted by people who make their living at this stuff.  Instructions at 
https://youtu.be/Qa0OI3g2FUM. 

o If changes to dates, details, and to add simple intro or outro text, by the same method. 

o You can Trim [crop] front, back or middle, at YouTube channel dashboard https://studio.youtube.com > 
left tab "Videos" > select our video > left tab "Editor". 
 Works in Firefox and Chrome.  Not Edge.  Don't know about Safari, Opera, Vivaldi nor Brave. 

o Blur faces (if we need to anonymize people's images), also at this place. 
o Add an End screen (presumably with links to other material, or link cards to publicize/promote other 

videos and such), also at this place. 

o Publicize/promote the video, with something like: 
 "https://youtu.be/videoname" (where "videoname" is the 11-character video identifier) (if 

audience needs video Description, 👍Thumbs Up, Subscribe or 🔔 notification bell), or 

 "https://youtube.com/embed/videoname" (where "videoname" is the 11-character video 

identifier) (if audience does not need to see video Description, 👍Thumbs Up, Subscribe nor 🔔 

notification bell), 
         and relevant parts of: 

https://studio.youtube.com/
https://studio.youtube.com/
https://youtube.com/channel
https://youtube.com/WildOnesRiverCityGrandRapidsAreaChapter/videos
https://youtube.com/channel/UCgLyuz9Ws3_pcodpiwKVRCg
https://aboutme.google.com/
https://aboutme.google.com/b/100004028594510235191
https://photos.google.com/b/100004028594510235191
https://studio.youtube.com/
https://studio.youtube.com/
https://youtube.com/upload
https://studio.youtube.com/
https://youtu.be/Qa0OI3g2FUM
https://studio.youtube.com/
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 "For full effect, select the video link, then icons ⛶ fullscreen, ㏄ captions, ▶ Play, and ⛶ ☒ Skip Ads. 

 If no captions are available, you can get captions from browser Edge (⊞Win+Ctrl+L) (and 

Chrome?), even if you are watching the video in another browser! 
o ⊞ Under Microsoft Windows, see https://support.microsoft.com/en-us/windows/use-live-captions-

to-better-understand-audio-b52da59c-14b8-4031-aeeb-f6a47e6055df#bkmk_turnoncaptions 
 "For additional reading, see links in the Description under button SHOW MORE. 

 "If you like what you see, give our video a 👍Thumbs Up, and Share. 

 "If you want to see more videos like this, Subscribe, and ring the 🔔 notification bell.  And see our 

YouTube channel https://youtube.com/WildOnesRiverCityGrandRapidsAreaChapter/videos." (Was 

https://youtube.com/channel/UCgLyuz9Ws3_pcodpiwKVRCg/videos.) 
Or my son's https://youtube.com/channel/UCcdVkcu8_YxWhoPz4IF44OQ/videos.  When Andy's YouTube 
channel grows to 100 subscribers, we can dramatically-shorten the URL to  
  https://youtube.com/AndrewPiehl/videos or  
  https://youtube.com/c/AndrewPiehl/videos,  
as is currently done by 

  https://youtube.com/WildOnesNativePlants/videos and  
  https://youtube.com/c/WildOnesNativePlants/videos, and  
  https://youtube.com/MissouriPrairie/videos and  
  https://youtube.com/c/MissouriPrairie/videos,  
according to https://support.google.com/youtube/answer/2657968. 

o After you get some Comments, you can Pin 1-to-3 comments to remain on top. 
o If we want to hand-correct the auto-captions, there is a way to do that.  But the auto-captions are pretty 

darn good. 
 

□ If you have your own website: 
o Modify a webpage to run that video in a player. 
o Perhaps tell the search engines about your new content. 

 

□ To learn more, see YouTube "creator academy" education at https://creatoracademy.youtube.com. 

□ TODO:  write:  Having YouTube keep a recording of what you stream originally on YouTube. 
□ TODO:  write:  Having YouTube rebroadcast what you stream originally to the Twitch.tv service. 

3.2.3 Stream on, or upload video, to Twitch.tv service 

□ TODO:  write:  Having your own channel or user on the Twitch.tv service. 

□ TODO:  write:  Having Twitch.tv service rebroadcast what you stream originally to YouTube? 
□ If you have your own website: 

o Modify a webpage to run that video in a player. 
o Perhaps tell the search engines about your new content. 

3.2.4 Upload video to Vimeo 

□ TODO:  write:  Having your own channel or user on Vimeo. 
□ TODO:  write:  Having Vimeo rebroadcast what you stream originally to YouTube or Twitch.tv. 
□ If you have your own website: 

o Modify a webpage to run that video in a player. 
o Perhaps tell the search engines about your new content. 

3.2.5 Upload video to X (formerly Twitter) 

□ TODO:  write:  Having your own channel or user on X (formerly Twitter). 
□ TODO:  write:  Having X (formerly Twitter) rebroadcast what you stream originally to YouTube or Twitch.tv. 
□ If you have your own website: 

o Modify a webpage to run that video in a player. 
o Perhaps tell the search engines about your new content. 

3.2.6 Stream on, or upload video, to Facebook 

□ TODO:  write:  Having your own channel or user (group?) on Facebook.  May be same as my write-up on 
Facebook. 

□ TODO:  write:  Having Facebook rebroadcast what you stream originally to YouTube or Twitch.tv. 
□ If you have your own website: 

o Modify a webpage to run that video in a player. 

o Perhaps tell the search engines about your new content. 

https://support.microsoft.com/en-us/windows/use-live-captions-to-better-understand-audio-b52da59c-14b8-4031-aeeb-f6a47e6055df#bkmk_turnoncaptions
https://support.microsoft.com/en-us/windows/use-live-captions-to-better-understand-audio-b52da59c-14b8-4031-aeeb-f6a47e6055df#bkmk_turnoncaptions
https://youtube.com/WildOnesRiverCityGrandRapidsAreaChapter/videos
https://youtube.com/channel/UCgLyuz9Ws3_pcodpiwKVRCg
https://www.youtube.com/channel/UCcdVkcu8_YxWhoPz4IF44OQ/videos
https://youtube.com/WildOnesNativePlants/videos
https://youtube.com/c/WildOnesNativePlants/videos
https://youtube.com/MissouriPrairie/videos
https://youtube.com/c/MissouriPrairie/videos
https://support.google.com/youtube/answer/2657968
https://creatoracademy.youtube.com/
http://ericpiehl.altervista.org/facebook.pdf
http://ericpiehl.altervista.org/facebook.pdf
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4 Business day before the presentation 
□ Inspect the site, doing everything possible in the next section, thus verifying that everything will work 

tomorrow. 
 

□ If you are going to use that site's 💻 computer and/or Wi-Fi and/or wired network, get the access 

credentials (e.g., userName and password) for them, and write them down below. 
o At AY_ CM, call your contact ____________________ at ___-861-2262. 

o At C_ (MCLH, B_C and elsewhere), call their IT group (open M-F 1-5p) at ___-526-8555. 

o DVP has Wi-Fi, but they won't let us use it. 
o SLC now has open Wi-Fi. 
o _Q has Wi-Fi, open or encrypted. 

 

□ Spellcheck your documents again!  
 

□ Make your mouse pointer easier to see. 
o Enlarge your mouse pointer size, particularly if you are presenting over videoconference software.   

 ⊞ Under Microsoft Windows, ⊞Win+I (or ⊞Start > [gear] Settings) > Ease of Access > left 

navigation bar Mouse pointer > slide Change pointer size to the right, maybe 3–15. 

 As of 2022, this size increase does not yet transmit over Zoom Share Screen. 

 🍎 Under Apple macOS, Settings > Accessibility > left navigation Display > top tab Cursor > check 

checkbox Shake mouse pointer to location > Cursor size to right 1 or 2 or 3 positions. 

o Change your mouse pointer color. 
 ⊞ Under Microsoft Windows, still at the above, try gold, red or pink! 

o Make your mouse pointer move faster, display mouse trails, and show its location. 

 ⊞ Under Microsoft Windows, ⊞Start > type "mouse" > select Change your mouse pointer or speed 

> tab Pointer Options > check Display pointer trails and Show location of pointer when I press 
the [Ctrl] key. 

 

□ Turn off notifications on your presentation 💻 computer.   

o ⊞ Under Microsoft Windows, perhaps via: 

 ⊞Start > Focus assist settings > When I'm duplicating my display > Off, or 

 ⊞Start > Notifications > Get notifications from apps and other senders > Off. 

 

□ Charge your 📱 smartphones, ▯ tablets, 💻 computers, wireless presentation-clicker(-remote-control)/laser-

pointers, 🎤🔊 wireless microphone/speakers, etc. 

 
□ You are ready!  At showtime, you want to live in the moment. 

If you don't feel ready: 
o Prepare.  Hard.  Over-prepare. 
o Exercise hard.   

o Center yourself, using whatever you need:  Yoga.  Long walk.  Play your 🎸 favorite instrument.  Garden.  

Cook.  Dance.  Whatever. 
o If you are reasonably-young or -urban, listen to Eminem Lose Yourself a few times. 
o Eat a good healthy and yummy dinner. 
o Get a great night's sleep. 

o Eat a moderate healthy breakfast, caffeinating normally. 
o Get your game face on. 
o You are ready.  You own it! 
o If it still doesn't feel right … 

  Fake it until you make it! 
 

5 Hour before the presentation 
□ Inspect your presentation site again. 

 

□ Find a 📺 TV or projection screen or blank wall of neutral color. 

o If needed, lower the projection screen. 

 At C_ MCLH or KC/MSUE, lower the screen using the up and down buttons on the wall column to the 
right of where the screen will be. 

https://www.lifewire.com/best-spelling-and-grammar-check-apps-4176088
http://icanseenature.altervista.org/natives.html
https://youtube.com/results?search_query=Eminem+Lose+Yourself
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 At C_ B_C, lower the screen using the up and down buttons on the wall to the left of where the screen 
will be. 

 

□ If your site already has a 💻 computer attached to the 📽 projector, and you are going to use it: 

o If you plan to see your speaker notes using Microsoft PowerPoint Presenter View at C_ (MCLH, B_C and 
elsewhere), do not use this option — it won't work without opening the lectern and moving an HDMI cable 

— so (A) bring your own 💻 computer, or (B) be prepared to open the lectern and move an HDMI cable and 

move everything back at the end.  TODO:  Using Google Slides? 

o If needed, 1/0 power on that 💻 computer. 

o Logon to that 💻 computer, using the access credentials obtained before: 

 At C_ (MCLH, B_C and elsewhere), use username="visitor" and password="c_____u______yy". 

 
o Bring up your content over the Internet, from a flash-drive/jumpdrive/thumbdrive/USB-attached SSD/USB-

drive/USB-key/USB-stick, or from your SSD/harddrive. 
 

o If you plan to see your speaker notes using Microsoft PowerPoint Presenter View: 

 Connect your 💻 computer to a 📽 projector or 📺 TV, via an HDMI cable (after 2005-2013) or VGA 

cable (before 2005-2013). 

 🍎 If Apple macOS (Macintosh, iMac, iBook, and MacBook) 💻 computer, you may need a USB-C-to-

HDMI, DisplayPort-to-HDMI, or Mini-DisplayPort-to-HDMI cable or adapter.  Look on the back 
and sides of your computer. 

 Some computers may need a USB-C-to-HDMI cable or adapter.  Look on the back and sides of your 
computer. 

 ⊞ If Microsoft Windows 💻 computer, you cannot do this via a USB-A cable nor Chromecast or 

other wireless device — your 💻 computer will not recognize it as separate screen. 

 ⊞ If Microsoft Windows 💻 computer, set ⊞Win+P (or desktop > right-click Display Settings > scroll 

down main pane to section Multiple Displays) to Extend.  If trouble, more details. 

 🍎 If Apple macOS (Macintosh, iMac, iBook, and MacBook) 💻 computer, System Preferences > 

Displays > tab Arrangement > uncheck checkbox Mirror Displays to extend display across both 
screens.  If trouble, more details. 

 Drag your presentation's PowerPoint window to appear on your private display. 
 In PowerPoint tab Slide Show, group Monitors, check checkbox Use Presenter View and set 

dropdown Show On to be your public display. 
o TODO:  Using Google Slides? 

 

□ If you are using your own 💻 computer: 

o If needed, supply power to that 💻 computer. 

o 1/0 Power on that 💻 computer. 

o Bring up your content from your SSD/harddrive, from a flash-drive/jumpdrive/thumbdrive/USB-
attached SSD/USB-drive/USB-key/USB-stick, or over the Internet. 

o If you need Internet access, acquire that: 
 Using wired Internet, over an Ethernet cable, either "Cat-5" or "Cat-6". 

-OR- 
 Over Wi-Fi, using access credentials obtained before. 

 At AY_ CM, SSID="A__ Public", psw="b___s___nnnn", ??= "IDYnnnn!". 

 At C_ (MCLH, B_C and elsewhere): 
o Be prepared to receive an SMS text message, or an email. 
o Tell your computing device to select Wi-Fi SSID="Guest". 

o Launch a web browser to some webpage not on their approved list (e.g., https://EricPiehl.com). 
o When instead of your expected webpage, C_'s system displays its own Guest Registration 

access page: 
 Choose a Register button, depending on how you want to authenticate yourself: 

 (1) Text/SMS Message (to you) [sometimes fails, sometimes succeeds], 

 (2) Email Address (to you) [most reliable and quickest if you can receive email], 
 (3) C__ Sponsored Access (email to your C_ sponsor who is monitoring their email right 

now [have not tried this], or 

 (4) I have an Event Code [have not tried this]. 
 Check the box to say you accept their terms, 
 Identify yourself by name, organization, and cellphone mobile number or email address. 

https://www.wired.com/story/the-right-way-hook-your-laptop-up-to-tv/
https://www.wired.com/story/the-right-way-hook-your-laptop-up-to-tv/
https://ericpiehl.altervista.org/
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 If the Guest Registration access page now says "Your network access should be available. 

Close your current browser, and open a new one to start browsing", you now probably 

have 10 minutes of access.  So get your presentation going.  But don't forget to . . . 
o If When you receive a response on your mobile cellphone via SMS text, type the code into the 

webpage above. 
o If you receive a response by email to you, open the email and click its link. 
o If a new browser tab says "Access Granted!", you are good to go (!) for [NEW] 24 hours 3 

weeks. 
o After 3 weeks, your access will expire, and you must repeat this whole process. 

 DVP has Wi-Fi, but they won't let us use it. 
 At SLC, SSID="theirOtherAcronym Guest", bring up a web browser to Register. 

o If you have other devices to connect, give them your email address and they will email you a 

password to use. 
 At _Q, SSID=: 

o "_QGuest" > bring up a web browser to click OK, or 

o "_QMedia" > psw="MascotSyyyy-1". 

 

□ If you are using your or your site's 📽 projector, connect it to your 💻 computer wirelessly or with a cable: 

o If needed, supply power to that 📽 projector. 

o Connect your 💻 computer to your projector wirelessly or with a cable: 

 ⊞ If Microsoft Windows 💻 computer, use an HDMI cable (after 2005-2013) or VGA cable (if you must 

—  before 2005-2013). 

 🍎 If Apple macOS (Macintosh, iMac, iBook, and MacBook) 💻 computer, use an HDMI cable (after 

2005-2013) or VGA cable (if you must —  before 2005-2013), via an adapter from your 💻 computer 

model's particular video output, which may be one of (depending on model) (🍎 Apple articles About the 

video ports on Mac and Connect to HDMI from your Mac): 

 Thunderbolt 3 or 4 (uses different cable, but same connector as USB-C), 

 USB-C Digital AV Multiport, 
 Thunderbolt 1 or 2 (uses different cable, but same connector as Mini-DisplayPort MDP), 
 Mini-DisplayPort MDP, 
 Mini-DVI, or 
 DVI. 

 Try hard not to use a USB-A cable.  While it may work, it requires you install a driver on your 💻 

computer, it will never handle 🔊 audio, and will never be able to see your speaker notes using 

Microsoft PowerPoint Presenter View (your 💻 computer will not recognize it as a separate display 

device). 

 To connect wirelessly over a Chromecast device on your 📽 projector, install the Chromecast app on 

your 💻 computer, and verify that it connects to your Chromecast device.  Keep in mind that you will 

never be able to see your speaker notes using Microsoft PowerPoint Presenter View (your 💻 

computer will not recognize it as a separate display device).  TODO:  Using Google Slides? 

 If you know of a different wireless technique, please let me know the details! 

o If the project is off, press its 1/0 power button once, and delay panicking until the 📽 projector has had 

60 seconds to warm up. 

 At C_ (MCLH, B_C and elsewhere), on the podium-top box, press its side button 📽 Projector ON. 

o If nothing on screen, open the lens cap. 

o If your 💻 computer content is not being projected, but instead says "No Signal" and "Source: not 

yours", press the 📽 projector's Source button. 

 At C_ (MCLH, B_C and elsewhere), on the podium-top box, press its side button Desktop or 💻 laptop. 

o If needed, zoom the 📽 projector, by a dial or moving the projector stand, maximizing use of the screen. 

o If needed, focus the 📽 projector.  Respect your audience--do a good job. 

o If needed, elevate/raise or lower the 📽 projector, usually so content reaches near the top of the screen. 

o If needed, keystone the 📽 projector. 

 

□ Bring up your content over the Internet, from a flash-drive/jumpdrive/thumbdrive/USB-attached SSD/USB-
drive/USB-key/USB-stick, or from your SSD/harddrive. 

 
□ If you plan to see your speaker notes using Microsoft PowerPoint Presenter View: 

o Connect your 💻 computer to a 📽 projector or 📺 TV, via an HDMI cable (after 2005-2013) or VGA cable 

(before 2005-2013). 

https://support.apple.com/guide/mac-help/about-video-ports-cpmh0014/mac
https://support.apple.com/guide/mac-help/about-video-ports-cpmh0014/mac
https://support.apple.com/en-us/HT204388
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 🍎 If Apple macOS (Macintosh, iMac, iBook, and MacBook) 💻 computer, you may need a USB-C-to-

HDMI, DisplayPort-to-HDMI, or Mini-DisplayPort-to-HDMI cable or adapter.  Look on the back and 

sides of your computer. 
 Some computers may need a USB-C-to-HDMI cable or adapter.  Look on the back and sides of your 

computer. 

 ⊞ If Microsoft Windows 💻 computer, you cannot do this via a USB-A cable nor Chromecast or other 

wireless device — your 💻 computer will not recognize it as separate screen. 

o ⊞ If Microsoft Windows 💻 computer, set ⊞Win+P (or desktop > right-click Display Settings > scroll 

down main pane to section Multiple Displays) to Extend.  If trouble, more details. 

o 🍎 If Apple macOS (Macintosh, iMac, iBook, and MacBook) 💻 computer, System Preferences > Displays 

> tab Arrangement > uncheck checkbox Mirror Displays to extend display across both screens.  If 
trouble, more details. 

o Drag your presentation's PowerPoint window to appear on your private display. 
o In PowerPoint tab Slide Show, group Monitors, check checkbox Use Presenter View and set dropdown 

Show On to be your public display. 

□ TODO:  Using Google Slides? 
 

□ Test that the system shows it OK: 
o ⛶ Fullscreen (no taskbar, volume level nor other distractions). 
 For .pdf, use Ctrl+L, or View > Full Screen Mode. 

 For .ppt and .pptx, use F5, or Slide Show > From Beginning. 

o If MS PowerPoint 2010 will not play a video or shows "Media Unavailable": 

 Install the latest version of the 🍎 Apple QuickTime player > "OK" "Help", click OK. 

 Set app QuickTime > Edit > Preferences > Player Preferences > uncheck checkbox "Show 
Content Guide at startup, as in https://discussions.apple.com/thread/8527642. 

 Restart PowerPoint and then try playing the video slide again. 

 Make a note to, after you are done with this project, uninstall the app, and do the rest of what the 
message says. 

 For .key, use ___? 

 For video files, your media player should have a ⛶ Fullscreen button, or View > Fullscreen. 
o Lighting:  test how to adjust! 

o Glare:  verify that you don't have this! 

□ If your presentation has 🔊 audio, test it. 

□ After adjusting the 💻 computer's 🔊 volume control, if still insufficient: 

o Look around for 🔊 external speakers.  If two speakers, one speaker has one cable going to the other 

speaker;  the other speaker also has: 
 Batteries or a power cable (if needed, supply power to it). 

-AND-  

 A cable ending in a headphone plug.  Connect it to your 💻 computer's headphone jack. 

 At C_ (MCLH, B_C and elsewhere), there is a headphone plug sticking out of the podium somewhere.  

Find it, and connect it to your 💻 computer's headphone jack. 

o Adjust the speakers' volume control. 
 At C_ (MCLH, B_C and elsewhere), on the podium-top box, press its side buttons Prog Vol+ or Prog 

Vol-.  If needed, press button Proj Mute. 

 

□ If your venue is large or you have a small voice, test the 🎤 microphone, without allowing POPS — most 

annoying!): 

o Your 🎤 microphone may be cordless or corded. 

o Turn off 🎤 microphone. 

o If sending your 🔊 audio through a 💻 computer: 

 You may need a 🎤 microphone with 🔊 audio plug of type 3½ mm male TRRS [4-conductor, stereo 

with mic] (not TS [2-conductor, mono], nor TRS [3-conductor, stereo]), with Tip Ring Ring Sleeve 
containing, respectively, analog signals for LeftAudio RightAudio Ground Microphone (CTIA) (not 

OMTP).  If any different, I have never found any adapter combination that will get you what you want. 

 If your room's 💻 computer does not take the above, you may need to plug your 🎤 microphone into a 

USB-A external stereo sound adapter pink jack, which you will then plug one of your 💻 computer's 

USB-A jack. 
 If your adapter is wide, you may need a USB-A extender cable. 

 If the cords don't give you enough wander space, you may need an optional headphone extender cable, 
compatible with the above. 

https://www.wired.com/story/the-right-way-hook-your-laptop-up-to-tv/
https://www.wired.com/story/the-right-way-hook-your-laptop-up-to-tv/
https://www.wired.com/story/the-right-way-hook-your-laptop-up-to-tv/
https://support.apple.com/downloads/quicktime
https://discussions.apple.com/thread/8527642
https://smile.amazon.com/gp/product/B00OJ5AV8I/
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 You may need to set up the 🎤 microphone. 

 ⊞ If Microsoft Windows 💻 computer: 

o Right-click Taskbar icon Speakers > Sounds > tab Recording > double-click yourMic > Device 
usage=Enable > button Apply > tab Listen > check Listen to this device, Playback through this 
device=Default Playback Device > button Apply. 

o Right-click Taskbar icon Speakers > Open Volume Mixer > set. 

o If you have a 🎤🔊 headset or head mic: 

 Place on the primary user's head such that mic is 5 cm (2 in) off a corner of their mouth (earwards), 
securely! 

 (Some [which?] 🎙🎤 professional microphone types can be put in front of your mouth.  Experiment.) 

 If wireless, clip the transmitter/battery box to their belt or place in a pocket, run the cable somewhere 
where it won't catch on things, and have them practice feeling for the on-off switch.  Don't hold the box 
in your hand. 

 Don't pass a head mic around the audience — find another mic. 

o If you have a lapel mic: 

 Clip to the primary speaker's clothing, in the center of their chest, over the top of their sternum, a 
hand-width down from their necktie knot, or about where a necklace would fall.  

 If wireless, clip the box to their belt or place in a pocket, run the cable somewhere where it won't catch 
on things, and have them practice feeling for the on-off switch.  Don't hold the box in your hand. 

 Don't turn your head wildly as you point to or look at things.  DROPOUT! 
 Don't cover the mic with your arm, as you point to things.  MUFFLE! 

 Don't pass a lapel mic around the audience — find another mic. 
 If you must hold a lapel mic, hold it by the clip, not the mic!  RUMBLES!  And hold below your chin! 

o If you have a push-to-talk-/PA-/CB-/truck-/airplane-/police-radio-type 🎙 microphone, hold: 

 hold the base against your chin, with 🎙 mic-part only 1½ cm (½ in) in front of your mouth.  Else 

MUFFLE! 

o If you have an in-stand-but-removable mic: 

 remove the 🎤 microphone from the stand, and practice as below ... 

o If you have a professional (heavy, expensive-feeling) 🎤 handheld microphone: 

 hold right on front of your mouth. 

o If you have a mass-market (lighter, cheaper-feeling) 🎤 handheld microphone: 

 below your chin (chestward), or 
 5 cm (2 in) off a corner of your mouth (earwards).  Else POPS! 

o If you have an in-stand-but-not-removable mic: 

 bend or adjust the stalk so the mic is below your chin (chestward), and practice talking over and not 
wandering away from it. 

o Turn on 🎤 microphone. 

o Test.  
o Set volume levels, and practice above.  And not walking underneath the speakers — feedback screech. 

o When good, turn off 🎤 microphone until you are ready to use it. 

 

o If above doesn't work, stop worrying about 🎤 microphones, and direct speakers to use their outside, 

teacher, or police-command voice. 
 

o If venue is equipped with T-coil / telecoil / hearing induction loop (a technology that transmits 🔊 audio 

to good hearing aids), find the little electronic box that controls it, and verify that is turned on! 
 

o Practice!   
 If your audience can't see your lips, speak a lot slower, especially if content is important. 
 Pauses are just fine. 
 Too loud is better than too quiet.  (Unless you are trying to draw in the audience's attention.) 

 If you have a tech person, ask them to keep an eye on sound levels, light levels, glare, etc., and if 
conditions change, adjust the levels. 

 

□ Breathe deep. 
□ Talk to your peeps. 
□ Go to the bathroom. 
□ Get some water. 

□ Turn on your wireless presentation-clicker(-remote-control)/laser-pointer. 
□ Remember that PowerPoint's laser-pointer effect is Ctrl+dragMouse. 

https://sambleckley.com/writing/pockets.html
https://sambleckley.com/writing/pockets.html
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o But, if you plan to see your speaker notes using Microsoft PowerPoint Presenter View, you will need to 
see both screens.  TODO:  Using Google Slides? 

□ Move the mouse pointer over to the right edge. 
o Verify that, in a moment, it disappears from sight. 

□ Turn on your 🎤 microphone. 

o Use it just like you practiced above, probably: 

 below your chin (chestward), or  
 5 cm (2 in) off a corner of your mouth (earwards). 

□ Breathe deep, a couple times. 
□ Show time!  You own it! 

 

6 During the presentation 
□ Never just read your slides!  Talk more. 

o If you are going to just read your slides, you should have made a video of the presentation, posted it on 
YouTube, and had everyone watch from home. 

 

□ Use your 🎤 microphone. 

o Unless you decided otherwise above, keep the mic below your chin (chestward), or 5 cm (2 in) off a 
corner of your mouth (earwards). 

o Don't walk underneath the speakers — feedback screech. 

o If your audience can't see your lips, speak a lot slower, especially if content is important. 
o Pauses are just fine. 
o Too loud is better than too quiet.  (Unless you are trying to draw in the audience's attention.) 

 
□ If you are presenting over videoconference software, there may be a couple-second delay before the software 

can get your new slide sent out.  So transition to the next slide while finishing the last sentence on the 

previous slide. 

 
□ Relax.  You are totally prepared. 
□ Engage with your audience. 
□ Take questions.  Take comments. 

o If the questioner is not miked or is not making good use of their 🎤 microphone, always repeat the 

question. 
□ Have fun! 

 

7 After the presentation 
□ Power down the 📽 projector by pressing its 1/0 power button.  If it says "Power?", then push it once 

more. 

o At C_ (MCLH, B_C and elsewhere), on the podium-top box, press its side button 📽 Projector OFF.  Twice. 

o To let the 📽 projector's fan cool it down, wait for a couple minutes before you unplug it. 

□ Shut down your 💻 computer, wireless presentation-clicker, speakers and any other equipment. 

□ Undo any cables, and pack away yours. 

□ Set the site's screen and equipment back to its original configuration (like you were never there). 
□ Take notes on any lessons learned, and . . . 

 
□ Follow up! 
□ The next day, if you installed QuickTime above to get around a problem, reboot and uninstall it: 

o ⊞ If running under Microsoft Windows, use ⊞Win+I (or ⊞Start > [gear] Settings or System 

Settings (formerly Control Panel) > Apps > tab Apps and features [optional > Programs 

and Features] > QuickTime > press or right-click > Uninstall > Yes, you are sure > wait.  When 

done, verify that QuickTime is no longer listed.  At your next convenience, reboot (under ⊞ Microsoft 

Windows, ⊞Start > 1/0 Power > Restart or Shutdown). 

 
 
 
-End.-   send comments to the author  
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